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 GFL-002 

Warnings, Cautions, and Notes 
as Used in this Publication 

Warning 

Warning notices are used in this publication to emphasize that hazardous voltages, 
currents, temperatures, or other conditions that could cause personal injury exist in this 
equipment or may be associated with its use. 

In situations where inattention could cause either personal injury or damage to equipment, 
a Warning notice is used. 

 

Caution 

Caution notices are used where equipment might be damaged if care is not taken. 
 

Note 
Notes merely call attention to information that is especially significant to understanding and 
operating the equipment. 

This document is based on information available at the time of its publication.  While efforts 
have been made to be accurate, the information contained herein does not purport to cover all 
details or variations in hardware or software, nor to provide for every possible contingency in 
connection with installation, operation, or maintenance.  Features may be described herein 
which are not present in all hardware and software systems.  GE Fanuc Automation assumes no 
obligation of notice to holders of this document with respect to changes subsequently made. 

GE Fanuc Automation makes no representation or warranty, expressed, implied, or statutory 
with respect to, and assumes no responsibility for the accuracy, completeness, sufficiency, or 
usefulness of the information contained herein.  No warranties of merchantability or fitness for 
purpose shall apply. 

The following are trademarks of GE Fanuc Automation, Inc. 

Alarm Master Helpmate ProLoop Series Six 
CIMPLICITY Logicmaster PROMACRO Series Three 
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Introduction 

Welcome 
Thank you for choosing Max-ON RX3i Hot Standby Redundancy software and GE Fanuc 
PACSystems™ RX3i controllers to implement your critical control project. 

Max-ON RX3i Software consists of several software components, some of which execute in a 
pair of Hot Standby PACSystems Max-ON RX3i Controllers, and some of which execute upon 
your programming workstation. 

The PACSystems controller-based software consists of a set of application blocks that 
perform the Redundancy portion of the Hot Standby application. These application blocks are 
provided as part of a Proficy™ Machine Edition Project that is the starting point of your 
redundant automation application. Using GE Fanuc’s Proficy Logic Developer PLC 
programming software, you add your application logic to this project, and then store the 
overall project to each of the Hot Standby controllers. 

The Max-ON RX3i Configuration Utility, which is launched from the Logic Developer PLC 
Project, provides a utility to allow the control system designer to customize the functionality of 
the redundant system. 

A Proficy View Max-ON RX3i Project is also provided to monitor the status of the Redundant 
System and to display diagnostic information. 

Chapter 
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With the Max-ON RX3i LD Project , you can: 
•  Create a Hot Standby system that operates using a combination of GE Fanuc 

Genius™ I/O, Field Control™, Series 90™-30 remote Genius drops, and Genius 
VersaMax™ I/O, as well as Series 90-30 and PACSystems RX3i Ethernet NIUs. 

•  Provide data synchronization using an Ethernet LAN. 

With the Max-ON RX3i Configuration Utility software, you can: 
•  View and Modify the parameters of the Hot Standby Redundancy system: 

•  Redundant System Parameters 
•  Synchronization Data Groups 
•  Synchronization Network Interface Parameters 
•  Genius I/O Bus definitions 

With the Max-ON RX3i View Project, you can: 
•  Establish a communication link to the Hot Standby CPUs to: 
� Monitor system-level alarms in real-time 
� Monitor performance characteristics in real-time 
� Display information about the Redundant system: Max-ON driver version, CPU 

modules 
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Installing Max-ON RX3i  Software 
System Requirements 

Max-ON RX3i Software may be installed on a PC that has the minimum requirements shown 
below: 

▪ 1 GHz Pentium class processor 

▪ 256 MB RAM or more 

▪ Windows XP Professional Service Pack 2, Windows 2000 Professional Service 

▪ Pack 4 

▪ 50 MB of free disk space 

NOTE: Max-ON RX3i Software requires Logic Developer PLC Professional Edition Release 
5.80 LD PLC SIM 1 or later. 

To Install Max-ON RX3i Software 
1. Make sure that you have installed Proficy Machine Edition release 5.8 SIM 1 or later. 

This is required to configure and program the Max-ON RX3i CPU. 

2. It is recommended that you close all applications including virus checking, Internet 
Explorer, and HMI software that might be running in the background.  You may need 
to check the task manager to determine if other applications are running.  As a further 
precaution, it is also recommended that you re-boot the PC to make sure components 
that Max-ON RX3i Configuration Utility needs to update are not running during the 
installation process. 

3. Put the Max-ON RX3i Software CD in CD-ROM Drive. 

4. Select the CD drive from Windows Explorer. 

5. Double click Setup.exe. 

6. Follow the user prompts to complete the installation.  
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Uninstalling Max-ON RX3i  Software 
Max-ON RX3i Software can be uninstalled only from the computer upon which it is installed. It 
cannot be uninstalled over a network. You can uninstall Max-ON RX3i Software from the 
Add/Remove Programs option on the Windows Control Panel or from the Windows Start 
Menu. 

If the computer has other GE Fanuc software products installed, Max-ON RX3i Software can 
be uninstalled without removing any files needed by those applications. To uninstall Max-ON 
RX3i Software, do the following: 

1. Choose Uninstall from the Start Menu or the Control Panel. 

2. A dialog box appears asking if you are sure you want to uninstall. 

3. Confirm the Uninstall. 

▪ All files relating to Max-ON RX3i Software will be removed from the hard drive. Any 
files used by both Max-ON RX3i Configuration Utility and another application will be 
left on the system. 

▪ All registry entries relating to Max-ON RX3i  Software will be removed from the 
systems registry. 

▪ Icons for Max-ON RX3i  Software will be removed from the Start Menu. 

▪ Any data you created (for example, Project that you have created) will be left on the 
system. 

Note: You may also uninstall Max-ON RX3i Software by choosing Add/Remove Programs 
from the Control Panel, then selecting Max-ON RX3i Tools. 
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Max-ON RX3i Component Installation 
The default settings for the Max-ON RX3i software installation places the Max-ON RX3i 
Software and the associated project components in the GE Fanuc Automation directory. 

The Max-ON RX3i components are installed in the tree structure as shown below: 
 

 
  
 
The Max-ON RX3i Configuration Utility is located in Max-ON RX3i Tools directory.  It is 
launched by double-clicking on the Max-ON RX3i configuration file (config.mx3) located in the 
Proficy Logic Developer PLC project. 

The default Max-ON RX3i Hot Standby Redundancy application project, named Max-ON RX3i 
LD Project vx_yy.zip, is located in the Redundancy LD directory.  This project must be 
brought into your Proficy Machine Edition development environment using Proficy Machine 
Edition’s File > Restore Project… menu. 

A Proficy View Diagnostic project is located in the Diagnostics VIEW directory. When it is 
active, this diagnostic utility displays key information regarding the operation and state of the 
redundant CPU pair. This project must also be brought into your Proficy Machine Edition 
development environment using Proficy Machine Edition’s File > Restore Project… menu. 
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Adding the Max-ON RX3i Hot Standby Redundancy Application 
Project to Proficy Machine Edition 
The default Max-ON RX3i LD project is added to the Machine Edition project Navigator by 
using the File > Restore Project…menu item.  Select the Project Navigator window making 
certain that there is no project open at this time. 
 

 
 

Using the File menu, click on Restore Project... 
 

 
 
 
Navigate to the Proficy Components directory, then to the Redundant LD directory.  Make 
certain that the selection for Files of Type has been set to Proficy Machine Edition (*.zip).  
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Select the Max-ON RX3i LD Project vx_yy.zip file.  
 

 
 

When you click on Open, a new project will be added to the Proficy Navigator window. 

Now you may give this new Project a descriptive project name. You may also use this project 
to create a Machine Edition project template that can me used as a starting point for future 
Max-ON RX3i projects. 

Launching the Max-ON RX3i Configuration Utility 
The Max-ON RX3i Configuration Utility is launched from the Machine Edition project.  Open 
the project that you restored in the previous section.  There are three targets in the project: 

 
•  PLC_A_HW – This target contains the hardware configuration for PLC A.  It must be 

edited to reflect the hardware settings and components in your system.  Then it must 
be downloaded to PLC A (only). 

•  PLC_B_HW – This target contains the hardware configuration for PLC B.  It must be 
edited to reflect the hardware settings and components in your system.  It will be very 
similar to PLC A hardware configuration, except for certain items such IP addresses, 
Genius bus controller settings, etc.  In a similar fashion, this configuration must be 
downloaded to PLC B (only). 
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•  PLC_COMMON_CODE – This target contains the core logic for the Max-ON RX3i 
redundancy application.  You must add your application logic starting in the rung that 
follows the call to the core Max-ON RX3i logic (hbr_000).  The logic from this target 
will be downloaded to both PLC A and PLC B.  Note that the download consists of the 
PLC Logic only, the Hardware Configuration option must be unchecked. 

You navigate to the Max-ON RX3i Configuration Utility by following these steps: 

1. Select the target PLC_COMMON_CODE. 

2. Expand the tree structure so that the Supplemental Files folder named Documentation 
Files is visible. 

 
 

3. Double-click on Documentation Files.  This will launch Windows Explorer for this 
directory. 

4. Click on the Max-ON Project directory to display its contents. The Explorer window will 
be similar to what is shown below. 

 

 
 

5. Double-click on the Max-ON RX3i Configuration file named config.mx3.  This launches 
the Max-ON RX3i Configuration Utility. 

6. You may now examine and edit the parameters of the Max-ON RX3i redundant 
system. 
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Technical Support 
Technical Support is available at no charge for 90 days after purchase. A support agreement 
can be purchased from your local GE Fanuc distributor if extended support is required. 
 

If problems arise that can’t be solved using the information in your product manual, online 
Help system, Proficy GlobalCare knowledge base, or the GE Fanuc Technical Advisor 
knowledge base, contact us by telephone, fax, or mail. When contacting us, call from a 
telephone near your computer and have your Machine Edition software running. Have the 
following information handy to help us assist you as quickly as possible: 

•  Proficy Machine Edition software installation serial number, the Proficy Machine 
Edition software Product name, and version number from the Help >About dialog box. 

•  The brand and model of any hardware in your system. 

•  Operating system and version number. 

•  The steps you performed prior to the problem occurring. 

GE Fanuc Global Care Web Site 
The GE Fanuc Global Care Web Site offers product, service, and support information for GE 
Fanuc hardware and software products. The Global Care web site is located at: 
http://globalcare.gefanuc.com/ 
Visit this site for the latest up-to-date technical information. 

North America 
Support Hotline: 1-800-GEFANUC (1-800-433-2682)  Fax: (780) 420-2049 
Internet: http://globalcare.gefanuc.com/    Email: support@gefanuc.com 
Comments about our manuals and help: doc@gefanuc.com 
Mailing Address: GE Fanuc, 2700 Oxford Tower, 10235 - 101 St., Edmonton, AB, Canada, T5J 3G1 

Asia 
Japan: Telephone 81-3-5405-7555; fax 81-3-5405-7550 
China: Telephone 0086-21-32224555 x200; fax 0086-21-62793066 

Europe, Middle East, and Africa 
Europe, Middle East, and Africa: + 800 1 GE FANUC or + 1 780-401-7717 
Internet: For up-to-date contact information, visit http://www.gefanuc-europe.com/. 
E-mail: support.emea@gefanuc.com 

South America 
Telephone: +58 (261) 760 2862     Fax: +58 (261) 765 0909 
Internet: http://www.gefanuc.com/ (visit our Portuguese web site at http://www.gefanuc.com.br/) 
E-Mail: luis.wilhelm@gefanuc.com 
Mailing Address: GE Fanuc Automation Latin America, Calle 120 con Av. 17, Los Haticos -GE Turbimeca 
Maracaibo, Venezuela 

http://globalcare.gefanuc.com/
http://globalcare.gefanuc.com/
http://www.gefanuc-europe.com/
http://www.gefanuc.com/
http://www.gefanuc.com.br/
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Online Help 
If you have a question about Max-ON RX3i, first consult the online help.  This may be 
accessed from the main menu in Max-ON RX3i Configuration Utility software.  To obtain help, 
select the main menu item Help, then Contents & Index. 

For PLC hardware questions, consult the documentation that was shipped with the hardware 
product. 
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System Overview 

Architecture 
A Max-ON RX3i Hot Standby Redundancy system consists of two PACSystems Max-ON 
RX3i Controllers, at least one dedicated Ethernet Synchronization link, and an I/O system 
comprised of at least one I/O LAN. 

The Ethernet Synchronization link is used to exchange status and synchronization data 
between the two Max-ON RX3i Controllers.  For higher system availability, dual redundant 
LANs may be employed. 

The I/O LAN is used to communicate with the I/O devices that are attached to it.  The I/O 
system may be implemented using a combination of Ethernet drops (Series 90-30 ENIU or 
PACSystems RX3i ENIU); or Genius drops (Genius I/O, Field Control I/O, VersaMax I/O, or 
Remote I/O drops based upon Series 90-30 I/O). The example below shows the Max-ON 
RX3i controllers connected to a single Ethernet I/O LAN. 

 

Max-ON RX3i has been designed to satisfy applications that have high performance 
requirements. It has support for up to 8 simplex or 4 dual Genius I/O busses, and up to 3 
Ethernet I/O busses.   

Chapter 
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The example below shows the Max-ON RX3i controllers connected to a single Genius I/O 
LAN. This example includes dual Ethernet synchronization LANs: 

 
Max-ON RX3i provides the following functionality: 

Discrete Inputs (%I)  2048  
Discrete Outputs (%Q)  2048  
Analog Inputs (%AI)  1024  
Analog Outputs (%AQ)  256  
Synchronized Internal Coils (%M) 4096  
Synchronized Registers (%R)  8000 

 I/O Busses  Up to eight simplex Genius busses, or  
   Up to four dual Genius busses 

Up to 29 devices per simplex or dual bus; 
Up to 3 simplex Ethernet busses, or one dual Ethernet bus 

Synchronizing LANs  One or two Ethernet LANs 
 CPU Model  IC695CMU310 
I/O Families  Ethernet: Series 90-30 Ethernet NIU or  
  PACSystems RX3i Ethernet NIU 
  Genius: Genius Block, Field Control, VersaMax,  
  Remote 90-30 Drop 
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Software Components 
Max-ON RX3i software consists of several components, some of which execute in the Hot 
Standby Controllers, and some of which execute in your programming workstation.  A base 
Logic Developer PLC Project provides the basic template for the Logic of the Redundant 
System.   This project is modified by the system designer to add the other necessary Logic to 
perform the user application, and then the final application is stored in the Controllers using 
Proficy Logic Developer PLC.  

You may think of the software provided in the Project template for the Controllers as “drivers” 
that handle the complex tasks associated with Hot Standby redundancy.  These drivers allow 
the two Controllers to behave as a single Controller from the perspective of your application. 

The Max-ON RX3i Configuration Utility allows the system designer to customize the 
parameters of the Max-ON RX3i drivers and to specify the hardware that is contained within 
the system. The Max-ON Configuration Utility software operates in Windows XP Professional, 
Windows NT4.0, and Windows 2000 Professional. 

The Max-ON RX3i Configuration Utility software allows you to define the way your system is 
constructed and how you want the system to operate.  It provides additional information that is 
not included in the Hardware Configuration files produced by Logic Developer PLC. 

The Max-ON RX3i software includes a Proficy View Diagnostic Project that allows you to 
observe the way your system is operating and helps you to diagnose problems. This Project 
displays the operational status of the redundant system in real time. 

The Max-ON RX3i software also includes a set of projects to configure Series 90-30 Remote 
Genius Drops.  

The Max-ON RX3i software components are organized as follows: 

 

A Max-ON RX3i Quick Start Project is also included on the Max-ON RX3i Software CD. This 
Quick Start Project also includes 3 RX3i ENIU targets. 
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Hot Standby Redundancy Operation 
During each controller scan, the Max-ON RX3i redundancy drivers are solved first, and then 
your application logic is solved.  The Max-ON RX3i redundancy drivers handle the following 
functions: 

▪ Determine Mastership – One CPU operates as the Master.  The other operates as the 
Backup.  Output devices use the output states from the Master only.  In a Max-ON RX3i 
system, the user may specify either PLC to be the preferred Master.  If no preference is 
specified, then Mastership “floats” between the PLCs.  The current Master retains its 
status until it fails or until the user switches Mastership, at which time the Master and 
Backup exchange their roles. 

▪ Transfer Synchronization Data – If the Master fails, the Backup must be prepared to 
control the process using the latest internal states from the ex-Master.  These states may 
represent such things as latched coils, timer/counter values, PID values, system set 
points, and perhaps user-calculated values.  

▪ Enforce an Orderly PLC Startup – When a failed PLC is returned to service, it must not 
attempt to assume control of the system prior to being synchronized to the current Master.  
If both PLCs startup simultaneously, then whichever one was the last valid Master 
assumes the Mastership. 

▪ Process Genius Dual Bus I/O Devices – When the system uses dual Genius I/O 
busses, input devices are mapped automatically from the active I/O LAN into the PLC’s 
input reference tables. 

▪ Execute Diagnostic Tests – Automatically post time-stamped fault messages into the 
Max-ON RX3i Alarm Table.  Identify system problems such as bus faults, loss of devices, 
change of Mastership, program restart, and power-up event. 
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Failover Time 
The Mastership Time of the Max-ON RX3i system determines the Failover Time. The Failover 
Time is the time required for control of the system to transfer from the Master Controller to the 
Backup Controller. 

Mastership Time:  This is the time interval for the Backup Controller to recognize that the 
Master Controller has failed.  It takes one or two CPU scans plus one Synchronized Data 
Transfer period to determine that the Master has failed.  Then it takes an additional scan to 
activate the output data stream in the Backup Controller. 

For the Ethernet I/O LAN, the Remote Ethernet drop will start using the data from the Backup 
Controller as soon as it detects that: 

1. The Backup is now the Master 

2. The Master is no longer sending data 

For the Genius IO LAN, Lacking output data from the current Master’s GBC, each output 
circuit on each device on the Genius I/O LANs will hold its last state for up to 2.5 seconds 
before it assumes the Default State unless there is output data from the Backup GBC.  (This 
assumes that each device has been configured for either BSM present or for long timeout.)  
Then the output device will begin using output data from the other GBC. 

Synchronized Data Transfers 
Data may be synchronized from the Master to the Backup on a continuous basis in order to 
assure that the Backup controller’s data is always in sync with the Master’s. Max-ON RX3i 
supports up to 6 groups of synchronization data for each data type listed below.  The groups 
do not have to be contiguous.  Each group is specified by a starting reference address and a 
length.  For each data type, the lengths are added together and the sum must not exceed the 
value in the corresponding column below.  

 Registers 

%R 

Discrete 
Outputs 

%Q 

Internal 
Coils 

%M 

Analog 
Outputs 

%AQ 
Max Length 8000 2048 4096 256 

Range 1 - 8000 1 - 2048 1 - 4096 1 - 256 
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I/O Bus Topologies 
The Max-ON RX3i application supports the use of single (non-redundant) and/or dual 
(redundant) busses interfacing to the I/O devices. 

▪ A Max-ON RX3i controller supports up to four Ethernet LANs. At least one Ethernet 
Interface must be dedicated to the Synchronization Link.  This allows up to 3 additional 
Ethernet Interfaces that may be used as dedicated Ethernet I/O LANs. Support is also 
available for a single duplex Ethernet I/O LAN. 

Simplex Ethernet I/O Busses Dual Ethernet I/O Busses 

Up to 3 1 

 

NOTE:  Redundant IP on the Primary and Secondary Synchronization LANs is not 
available. 

▪ Max-ON RX3i supports up to four redundant Genius LANs or up to eight non-redundant 
Genius LANs, or a mixture of the two.  However, the system may not have more than 
eight Genius bus controllers in a Controller. 

Simplex Genius I/O Busses Dual Genius I/O Busses 

Up to 8 Up to 4 

Redundant busses are superior to non-redundant busses when there is a requirement to 
protect against cable failures or Genius bus controller failures. 

When the primary consideration is to protect against cable failures, then the system designer 
should consider separating the cables so that a single mechanical failure does not damage 
both cables. 

Genius Dual Bus I/O Capacity 
The maximum allowable I/O capacity for Max-ON RX3i redundant system that is configured 
for Genius Dual busses is as follows: 

Discrete 
Inputs 

Discrete 
Outputs 

Analog 
Inputs 

Analog 
Outputs 

2048 2048 1024 256 
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Selecting the I/O 
Max-ON RX3i systems may be implemented using any combination of the following I/O: 

Ethernet NIUs  Ethernet NIUs are remote I/O drops that as based on standard 90-30 or 
PACSystems RX3i hardware. These remote drops communicate to the redundant 
controllers using Ethernet Global Data. These NIUs are configured using Logic 
Developer PLC. 

Genius Block Genius blocks are intelligent, self-contained, configurable I/O modules. The blocks 
are available as discrete, analog, and special purpose types, such as the high-
speed counter.  Many of the blocks offer advanced diagnostic capabilities such as 
open circuit, short circuit, and overload detection.  Each block is configured using a 
hand-held monitor. 

Genius Field Control Genius Field Control is a family of versatile, modular I/O devices. The I/O modules 
are small and rugged and are available in both discrete and analog versions. 
I/O Terminal Blocks provide universal field wiring terminals for the I/O modules, 
allowing I/O module types to be mixed on the same I/O Terminal Block. The I/O 
Terminal block is mounted on a DIN rail. 
As many as eight Field Control I/O modules (four I/O terminal blocks) can be 
connected to one Bus Interface Unit. Together, they make up a Field Control 
“station”.  The bus interface unit provides either a single or a dual, redundant LAN 
connection to the Hot Standby PLCs. 
Each station is configured using a hand-held monitor. 

Genius Remote 90-30 
Drop 

Genius Remote 90-30 drops consist of a Series 90-30 CPU, power supply, base 
plate, and one Genius bus controller for a single LAN connection or two bus 
controllers for a dual, redundant LAN connection. Normally, input and output 
modules are installed in the base.  A Scanner routine executes in the drop’s CPU.  
This routine scans all input devices and transmits the input states to the Hot 
Standby PLCs. 
The routine also monitors outputs (%Q and %AQ) in the Synchronized Data stream 
from the Hot Standby PLCs.  Any output data that is configured to be active in the 
remote drop is captured from the data stream and then is mapped into the Drop’s 
output reference tables. 
Configuration of the remote drop is accomplished using the Logic Developer PLC 
software package.  Also, a few rungs of ladder logic must be edited in order to 
characterize the outputs in the drop. 

Genius VersaMax Genius VersaMax I/O products feature DIN-rail mounted modules with up to eight  
I/O and option modules per “rack” and up to 8 racks per VersaMax I/O Station 
system. Expansion racks can be located up to 750 meters from the main VersaMax 
I/O Station rack. Expansion racks can include any VersaMax I/O, option, or 
communications module. 

Genius Third Party In some cases, third party devices may be used on the LAN as well.  These devices 
must comply with the Genius I/O specification relating to Controller Redundancy.   

With a Max-ON RX3i system, you may select I/O devices based upon functionality, cost, 
physical design, items carried in spare parts inventory, or personnel expertise. 
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Demo Mode Operation 
A Max-ON RX3i application will operate in demo mode for 22 days on standard PACSystems 
RX3i CPU hardware (IC695CPU310).  In this mode, all of the system’s capabilities are fully 
operational.  At the end of the demo period, PLC A will either stop immediately, if it is the 
backup, or begin an orderly transfer of Mastership to PLC B.  If the transfer is successful, then 
PLC A will shut down automatically. At this point, the system will be operating in a non-
redundant manner. 

A Max-ON RX3i system that is installed in a production environment MUST be running on a 
Max-ON RX3i CPU (IC695CMU310) in order to allow PLC A to run indefinitely. 

Running Max-ON RX3i on a standard RX3i CPU is helpful for short times in case of a 
hardware failure or for non-production demonstration purposes. 
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Building a Max-ON RX3i Hot Standby Application 

Max-ON RX3i Project  
▪ Max-ON RX3i encapsulates your entire application within a single Machine Edition 

Project.  Using a generic Max-ON RX3i Project, you can create a new Max-ON RX3i 
Redundancy project. The generic project contains all of the base Max-ON RX3i 
redundancy application components needed to perform the redundant application. You 
add the hardware configuration information for each PLC in your application, add your 
application logic, and define the parameters of the Redundant System using the Max-
ON RX3i Configuration Utility that us launched from the Logic Developer PLC Project. 
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Project Workflow 
Step 1 - Gather Information 
Gather the information about your system: 

▪ I/O Bus topologies and addresses 

▪ Synchronization LAN locations 

▪ Module types and locations 

▪ I/O Devices including bus assignment, bus addresses, circuit references, number of 
circuits and I/O family type. 

Step 2 - Create a New Max-ON RX3i Project 
In Proficy Logic Developer PLC: 

1. Create a new project based on the Generic Max-ON RX3i Project. The redundant 
ladder project is added to the Machine Edition project Navigator by using the File > 
Restore Project… menu item.  Select the Project Navigator window making certain 
that there is no project open at this time. 

 

2. Using the File menu, click on Restore Project...  
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3. Navigate to the Proficy Components directory, then to the Redundant LD directory.  
Make certain that the selection for Files of Type has been set to Proficy Machine 
Edition (*.zip). 

 

 
 

 
When you click on Open, a new project will be added to the Proficy Navigator window. 

 

 
  

4. Give your project a descriptive name in the Machine Edition Navigator. 

5. Enter Project Setting information by launching the Project Settings dialog in the Max-
ON RX3i Configuration Utility. .  (Refer to Chapter 4 for more information.)  

6. Enter Developer and End User Information by launching the Biographical Information 
dialog in the Max-ON RX3i Configuration Utility. .  (Refer to Chapter 4 for more 
information.) 
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Step 3 - Configure the Controller Hardware 
In Logic Developer PLC: 

For CPU A: 

1. Open the Hardware Configuration for PLC_A_HW target in the Max-ON RX3i Project. 

2. Configure the PLC hardware for PLC A: 

▪ CPU Memory 

▪ CPU SNP ID 

▪ Genius Bus Controllers 

▪ I/O Devices on the Genius Bus (or Busses) 

▪ Ethernet Modules  

o Ethernet IP Address and Subnet Mask 

o Device Status Address 

▪ Ethernet Global Data (EGD) Exchanges for Ethernet NIUs 

3. Store the new hardware configuration into CPU A 

4. Set the time and date for CPU A. 

For CPU B: 

1. Open the Hardware Configuration for PLC_B_HW target in the Max-ON RX3i Project. 

2. Configure the PLC hardware for PLC B.  

▪ CPU Memory 

▪ CPU SNP ID 

▪ Genius Bus Controllers 

▪ I/O Devices on the Genius Bus (or Busses) 

▪ Ethernet Modules  

o Ethernet IP Address and Subnet Mask 

o Device Status Address 

o Ethernet Global Data (EGD) Exchanges for Ethernet NIUs 

3. Store the new hardware configuration into CPU B. 

4. Set the time and date for CPU B. 
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Step 4 - Add Your Application Logic 
Using Logic Developer PLC, open the PLC_COMMON_CODE Target folder and add your 
application logic after the call to the subroutine named HBR_000. 

 

If you are using an Existing Project 

If you have developed the application previously, then you may copy and paste the Max-ON 
RX3i logic into the existing Project.  A Machine Edition Toolchest drawer is also provided that 
may be used to copy the Max-ON Blocks into the Project. 

If this is a New Application 

Add your application logic into the project folder directly after the CALL to the hbr_000 Block 
in _MAIN Rung 3. 

Step 5 - Configure the I/O Devices 

Ethernet NIUs 

If you are using Ethernet NIUs, then you will need to create Ethernet NIU targets, configure 
the I/O in the remote drop, and then download the ENIU information to the remote drop using 
Logic Developer PLC. 

Genius or Field Control 

If you are using Genius or Field Control, then set the appropriate parameters for Serial Bus 
Address, I/O Settings, I/O Quantities, Redundant Controllers, BSM present (always set to 
yes), BSM Controller (set to yes when a dual I/O bus is used), etc. 
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Genius VersaMax I/O 

In Logic Developer PLC, add a Target for each VersaMax I/O Drop.  Add the appropriate 
modules to the drop and then configure the parameters for each module.  Connect to each 
drop with a serial cable and then store the configuration data. 

Remote Genius 90-30 Drops 

If you are using Remote Genius 90-30 Drops, then configure the Genius bus controller(s), and 
edit the configuration rungs in the remote’s I/O driver.  Make certain that Synchronized Data 
has been configured for the range of outputs used by the Remote Drop. 

Step 6 - Start the System 
Divide the system into manageable subsystems that may be verified as independent entities. 

I/O Bus 

▪ Make certain that the Ethernet LAN(s) have been installed and configured correctly. 

▪ Make certain that the Genius LAN(s) have been installed correctly... LAN polarity and 
shield IN/OUT are connected consistently and correctly.  Also make certain that 
terminating resistors are installed at each end of the LAN(s). 

▪ Genius and Field Control – Using a Handheld Monitor, verify that output devices may 
be turned ON or OFF from the LAN. 

▪ Use the Handheld Monitor check the LAN for any Bus Error activity. 
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I/O Devices 

When Interfacing to CPU A: 

With the I/O operating, place CPU A in RUN mode and CPU B in STOP mode. 

▪ Verify that the system input devices return real-time values properly. 

▪ Verify that system output devices may be controlled from the Output Reference 
Tables.   

Note: This might require that you place a temporary JUMP in your application.  The JUMP 
should be placed immediately after the CALL to HBR_000.  The companion label should be 
placed at the end of _MAIN. 

When Interfacing to CPU B: 

With the I/O operating, place CPU A in STOP mode and CPU B in RUN mode. 

▪ Verify that the system input devices return real-time values properly. 

▪ Verify that system output devices may be controlled from the Output Reference 
Tables. 

Hot Standby Operation 

1. Place both CPUs into RUN mode. 

2. Make certain that there is only one Master and only one Backup. 

3. Make certain that there is no preferred Master. 

4. Place CPU B into STOP mode, and then into RUN mode. 

5. Make certain that Synchronized Data is transferred properly to CPU B. 

6. Transfer Mastership from A to B by placing the CPU A into STOP mode. 

7. Make certain that the I/O did not dropout during the transfer. 

8. Place CPU A into RUN mode. 

9. Make certain that it becomes a Backup properly.  

10. Transfer Mastership from B to A by placing the CPU B into STOP mode. 

11. Make certain that the I/O did not dropout during the transfer. 

12. Place CPU B into RUN mode. 

13. Make certain that it becomes a Backup properly.  

14. Make certain that Synchronized Data is transferred properly to CPU B. 
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Step 7 - Debug the System 

Use the Max-ON RX3i View Diagnostic Project 

▪ Restore the Proficy View Project from the installation directory into Proficy Machine 
Edition. 

▪ Enter the Ethernet Addresses of PLC A and PLC B into the Proficy View Project. 

▪ Download and Run the View Project on your workstation. 

▪ Examine the Alarm and the Real-time Status displays. 

Simplify the System 

Here are a few suggestions from other system developers that have worked well. 

▪ Turn OFF one PLC and troubleshoot the system using the remaining one. 

▪ Disable Max-ON RX3i drivers by placing an #ALW_OFF contact prior to the call to 
HBR_000.  Now determine if input/output devices operate properly. This will require 
that you modify the hardware configuration for the Genius bus controllers.  Place them 
in “Enable at Start”.  Don’t forget to change the configuration to “Disable at Start” when 
it is time to place the system into its final, redundant operation. 

▪ Disable your application code and troubleshoot the Max-ON functionality.  Check to 
make certain that synchronized data items transfer properly.  Check to make certain 
that the Hot Standby CPUs will exchange mastership properly. 
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The Max-ON RX3i Configuration Utility 

The Max-ON RX3i Configuration Utility is used to create or edit the operating parameters 
used by the Max-ON RX3i redundancy drivers.  These parameters specify such things as, bus 
topologies, I/O addresses, and definitions for the ranges of synchronized data transfers. 

Max-ON RX3i Projects 
A Max-ON RX3i Project is a collection of items needed to define the elements of a redundant 
system.  If you inspected a Max-ON RX3i Project using Logic Developer PLC, you would see 
that it consists of a Machine Edition Project with 3 Targets: 

•  PLC_A_HW – This target contains the hardware configuration for PLC A.  It must be 
edited to reflect the hardware settings and components of PLC A in your system.  
Then it must be downloaded to PLC A (only). 

•  PLC_B_HW – This target contains the hardware configuration for PLC B.  It must be 
edited to reflect the hardware settings and components of PLC B in your system.  It 
will be very similar to PLC A hardware configuration, except for certain items such IP 
addresses, and Genius bus controller settings.  In a similar fashion, this configuration 
must be downloaded to PLC B (only). 

•  PLC_COMMON_CODE – This contains the core redundancy logic for the Max-ON 
RX3i redundancy application.  You must add your application logic starting in the rung 
that follows the call to the core Max-ON RX3i logic (hbr_000).  The logic from this 
target will be downloaded to both PLC A and PLC B.  Note that the download consists 
of the PLC Logic Only, the Hardware Configuration option must be unchecked. 
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The diagram below illustrates how the Max-ON RX3i Project is organized: 

 

When creating a Max-ON RX3i Project, the best approach is to start with the generic project 
that is supplied with the Max-ON RX3i software. This assures that all of the basic components 
of the Max-ON RX3i redundant application are included in the project.  

Creating a New Max-ON RX3i Project 
To create a new Max-ON RX3i Project in Proficy Logic Developer PLC: 

1. Create a new project based on the generic Max-ON RX3i Project. A new Max-ON 
RX3i Project is added to the Machine Edition project Navigator by using the File > 
Restore Project… menu item.  Select the Project Navigator window, making certain 
that there is no project open at this time. 
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2. Using the File menu, click on the Restore Project... menu. 

 

3. Navigate to the Proficy Components directory where the Max-ON RX3i Tools software 
has been installed, then to the Redundant LD directory.  Make certain that the 
selection for Files of Type in the Restore dialog has been set to Proficy Machine 
Edition (*.zip). 

 

4. When you click on Open, a new project will be added to the Proficy Navigator window. 

 

5. Give your project a descriptive name in the Machine Edition Navigator. 
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Launching the Max-ON RX3i Configuration Utility 
The Max-ON RX3i Configuration Utility is launched from the Max-ON RX3i Machine Edition 
Project.  For example, open the project that you created in the previous section. Navigate to 
the Max-ON RX3i Configuration Utility by following these steps: 

1. Select the target PLC_COMMON_CODE node in the Navigator. 

 

2. Expand the tree structure so that the Supplemental Files folder named Documentation 
Files is visible. 

 
 

3. Double-click on Documentation Files.  This will launch Windows Explorer for this 
directory. 
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4. Click on the Max-ON Project directory to display contents. The Explorer window will be 
similar to what is shown below. 

 

 
 

5. Double-click on the Max-ON RX3i Configuration file named config.mx3.  This launches 
the Max-ON RX3i Configuration Utility. You may now examine and edit the parameters 
of the Max-ON RX3i redundant system. 

Note:  The cfg_dat.gefelf file in the Max-ON Project directory is the C Block that is 
modified by the Max-ON RX3i Configuration Utility. After the utility has updated this file, 
you must update the cfg_dat C Block that is located in the PLC_COMMON_CODE target 
in the Max-ON RX3i Project. 
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Working with the Max-ON RX3i Configuration Utility 
Now that you have created a Max-ON RX3i Project and launched the Max-ON RX3i 
Configuration Utility, you can set the parameters of the redundant system. When the Max-ON 
RX3i Configuration Utility is launched it will display the following: 

 

As you can see from the Project Navigator, the utility allows you to specify the following 
information about the Max-ON RX3i redundant system: 

•  Developer: Biographical information of the engineer who developed the application. 

•  End User: Biographical information about the end user. 

•  Settings: Specifies the Max-ON RX3i System Parameters. 

•  Sync Data: Specifies the synchronization data that is to be transferred from the 
Master CPU to the Backup CPU in order for the redundant system to be synchronized.  

•  Sync Networks: Specifies the Ethernet LAN configuration to be used to transfer the 
Synchronized Data. 

•  Genius Busses: Specifies the Genius Busses used by the redundant system for 
Genius I/O. 

•  User Alarms: Allows the user to create self-defined faults that can be logged by the 
Max-ON RX3i redundant application.  
Note: User Alarms are not available in the current version of Max-ON RX3i 
Diagnostics. 



 
                                                                                  

GFK-2409A Chapter 4  The Max-ON RX3i Configuration Utility  4-7 
 

4    

Developer and End User Information 
By selecting the Developer and End User items in the Project tree, the information about the 
engineer who developed the application –and- the end user may be displayed and modified. 
To edit this biographical information, double-click on the Developer or End User item in the 
project tree or select the Edit > Properties menu item. The Biographical Information dialog is 
now displayed and the detailed information may be entered and saved. 

 

Settings 
By selecting the Settings item in the Project tree, the Max-ON RX3i System Parameters 
settings may be displayed and modified. These parameters are defined as follows. 

 

Fast Offline Detection - Enabling this option directs the CPUs to detect an offline condition 
within one CPU scan. If the option is not enabled, then it will require two consecutive scans to 
produce an offline condition. 

Program Change Audit Trail - Checking this box instructs the Max-ON RX3i redundancy 
system to monitor the program for changes to logic.  If there is a change, the value in the 
change counter, UR_N1 (%R9003/9004; DINT), will be incremented by one, and a date/time, 
PDAT_01 (%R9005.9007, packed BCD), will be posted for the moment at which the change 
was detected. 
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Default Multiplexer Period - This value is the default time period used to advance the 
Synchronized Data multiplexer.  This is used when there are Remote 90-30 Drops present on 
a Genius I/O LAN. 

Sync Data 
Synchronization data from the %M, %Q, %AQ, and %R reference tables may be transferred 
from the Master CPU to the Backup CPU in order for the redundant system to be 
synchronized. By selecting the Sync Data item in the Project tree, the Max-ON RX3i Sync 
Data settings may be displayed and modified. 

 

Synchronized data may be transferred in up to 6 groups for each of the reference tables listed 
above.  This allows transfer of non-contiguous data areas.  The general format uses a Start 
Reference and a Length. 

To add a new address range to a data group, select the Data Group tab in the table, and then 
select the Sync Data -> Add Data Item… menu. 

Now enter the new range for the new data group for this reference table. 
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Maximum Sync Data 
For each Synchronized Data type, the system will sum the lengths in each configured group 
to arrive at a total amount for that data type.  The total must not exceed the size listed in the 
table below:  

Registers 

%R 

Discrete Outputs 

%Q 

Internal Coils 

%M 

Analog Outputs 

%AQ 

8000 2048 4096* 256 
*The system flags, although included in this number, are not transferred. 

Sync Networks 
When using Max-ON RX3i, one or two Ethernet LANs may be configured using an 
IC695ETM001 interface card to transfer the Synchronization Data. If you are using a dual 
Ethernet LAN topology, then you may use two ETM001 modules in each PLC for the Sync 
LANs. When the Ethernet module has been configured in the Logic Developer PLC hardware 
configuration, you must assign the module a device status address.  Generally, it is a good 
practice to place these in the upper area of the %I reference memory.  (Note:  The address 
must be set to %I01969 or lower.) 

When dual Ethernet LANs are used, you must specify which device is to be the Primary 
device and which is to be the Secondary device. The Ethernet Modules must be in the same 
slot positions in each of the two RX3i main racks. 
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To display the configuration of the Sync Networks Interface Modules, expand the Sync 
Networks node in the Project tree. Now the configurations of the two Primary Interface 
modules are displayed. 

 

To edit this information, double-click on the LAN Interface Modules item in the project tree or 
select the Module > Properties… menu item. The Ethernet Modules configuration dialog is 
now displayed and the information about them can be entered. 
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Configuring Dual Sync Networks 
If you want to use a dual Ethernet Sync Networks, then you must use two ETM001 modules in 
each PLC for the Sync Network. In this case, you need to define the Secondary Sync 
network. To add a Secondary Sync Network to the Max-ON RX3i system, select the Sync 
Networks node in the project tree. Then select the Networks > Redundancy > Add Secondary 
Network… menu item. 

 

Now the Secondary Network will be added to the system, and  parameters may be 
configured. 

 

To edit the Secondary LAN information, double-click on the LAN Interface Modules item in the 
project tree or select the Module > Properties… menu item. 

Note: The Ethernet LAN information that is placed in the Max-ON RX3i Configuration must 
match the configuration information that is placed in PLC_A_HW and PLC_B_HW hardware 
configurations in order for the system to operate properly. 
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Genius Busses 
By selecting the Genius Busses item in the Project tree, the Max-ON RX3i Genius busses 
may be displayed and their settings may be modified. By default, no Genius busses are 
defined, so you must configure the bus definitions to match your hardware configuration. 
Genius busses can be defined as a Simplex or a Duplex bus. 

Simplex Genius Bus 
A simplex Genius Bus is a non-redundant I/O bus that connects to one or more Genius I/O 
devices. 

To Add a Genius Bus  
1. To add a new Genius Bus, select the Genius Busses item in the Project tree, then 

select the Busses >Add Genius Bus.. menu item. 
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2. Give the Genius bus a descriptive name, such as “Main”, and change the Baudrate 
setting if necessary.  

 

3. After the Genius bus has been created, it is added to the Project tree and now Genius 
devices may be added to this bus.  
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4. Double-click on the Primary Bus Controller item in order to configure  parameters, or 
select the Busses > Properties… or Module > Properties… menus. Enter the module’s 
location in the RX3i main rack and it’s status address. A suggested practice is to 
address devices such as Genius bus controllers and Ethernet modules at high 
addresses.  This leaves the low addresses available for Input devices such as field 
sensors. 
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Adding a Secondary Genius Bus 

To add a Secondary Genius Bus to an Existing Genius Bus  
1. Select the Genius Bus in the Project tree, and then select the Busses > Redundancy… 

> Add Secondary Bus.. menu item to add a Secondary Genius Bus. 

 

2. A Secondary Genius Bus Controller is added to the Project tree. 
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3. Double-click on the Secondary Bus Controller in order to configure it’s parameters, or 
select the Busses > Properties… or Module > Properties… menus. Enter the module’s 
location in the RX3i main rack and it’s status address.  A suggested practice is to 
address Genius bus controllers at high addresses.  This leaves the low addresses 
available for Input devices such as field sensors.  (Note:  The input address must be 
set to less than %I02017.) 
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Adding Genius I/O Devices 
To add Genius devices to a Genius Bus, select the Genius I/O item in the Project tree. Now 
the I/O Assignments table is displayed which lists the Genius Devices that are assigned to the 
various SBAs (Serial Bus Addresses). 

 

To add a Genius I/O device to this Genius Bus: 

1. Select an SBA for the new Genius device by clicking on the gray button to the left of the 
SBA number. A “*” will be placed on the button to indicate it’s selection. 

2.  Select the Bus Devices > Add Device… menu item. The Add New Genius Device dialog 
is displayed. 
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3. Click in the cell labeled I/O Family.  A dropdown list will appear: 

 
4. If the I/O Family is Genius, then select the I/O Type for the I/O device. Click in the cell 

labeled I/O Type.  A dropdown list will appear: 
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5. Select the I/O Type for the device, using the drop down list selections.  If your I/O device 
does not match with any of the selections, then select Generic.  Also, you should select 
Generic if the device is a Remote 90-30 Genius drop. 

6. Click the Apply button to assign the I/O Family and I/O Type. (Note:  If this is a dual bus, a 
reminder may be displayed to ask you to verify the starting address for the Secondary Bus 
Reference.) Click Ok. 

 

7. Click on the I/O Device type tab that is now active, [Discrete In], for example. 
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8. Edit the device properties for both the Primary and Secondary busses. 

9. Click Apply and Ok to complete the changes or Cancel to leave without making any 
changes. 
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Editing Genius I/O Devices 
1. To edit a Genius device’s parameters, select the Genius I/O item in the Project tree for a 

specific Genius Bus. 

2. Select a Genius device by clicking on the gray button to the left of the SBA number. A “*” 
will be placed on the button to indicate it’s selection. 

3. Select the Bus Devices > Properties… menu item. The Edit Genius Device dialog is 
displayed. 

 

4. Edit the device properties 

5. Click Apply and Ok to complete the changes or Cancel to leave without making any 
changes. 

Deleting Genius I/O Devices 
1. To delete a Genius device, select the Genius I/O bus from the Project tree for the item to 

be deleted. 

2. In the device table, select the Genius device by clicking on the gray button to the left of its 
SBA number. A “*” will be placed on the leftmost column and row to indicate that the 
device has been selected. 

3. Select the Bus Devices > Delete Device… menu item. The device will be deleted. 
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Configuring Genius Discrete Inputs 
The Genius Device dialog allows you to configure Genius discrete inputs.  If the bus to which 
this device is attached has been configured to have a Secondary bus controller, then both the 
Primary Bus and Secondary Bus information will be displayed. If this is a single (non-
redundant) bus, then only the Primary Bus information will be displayed. 

 

Discrete Inputs – Primary Bus 
This field defines the base address assigned to the discrete inputs.  This address establishes 
the references that the input devices will use while they are connected to the Primary bus.  
These are the same references that will be used throughout the user application logic. 
 
%I Reference The first reference address used within the discrete input group. 
%I Length The number of discrete references that are to be included on this 

device. 
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Discrete Inputs – Secondary Bus 
When a dual bus is used, there must be an alternate location for the Genius discrete inputs to 
report their status.  The alternate location is the reference area in which the inputs will appear 
while they are connected to the Secondary Genius I/O bus. 

Max-ON RX3i redundancy drivers detect when the Primary inputs are unavailable.  If the 
Secondary inputs are reporting into the Secondary reference area, the drivers will map the 
data automatically from the Secondary area into the Primary address locations.  This permits 
the user-application to be written with references to the Primary addresses only. 

Reference The first reference address used in the Secondary (alternate) reference 
table. 

If the Primary Bus %I Length is a multiple of 16, then the inputs will be 
mapped into the RX3i register table. This value is read-only. 

If the Length is an odd multiple of 8, then the inputs may be mapped 
into either %I or %G references. You may select the desired reference 
type and address for the Secondary location. 

Length (words) The number of discrete references that are to be included on this 
device.  This is a read-only value that is generated from the number 
that was entered into the Primary Bus %I Reference. 
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Configuring Genius Discrete Outputs 
The Genius Device dialog allows you to configure the Genius discrete outputs.  The main 
purpose of this configuration is to identify the device and the circuit reference so that online 
status may be monitored.  Any offline/online activity will be reported in the Max-ON RX3i Fault 
Table. 
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Configuring Genius Analog Inputs 
The Genius Device dialog allows you to configure how the Max-ON RX3i redundancy driver 
will process Genius analog inputs.  The analog inputs may be configured on a per circuit 
basis. 

 

Analog Inputs - Primary Bus 
The Primary Bus addressing is the base address assigned to the analog inputs.  This address 
establishes the references that the analog input devices will use while they are connected to 
the Primary Bus.  These are the same references that will be used throughout the user 
application logic. 
%AI Reference The first reference address used within the discrete input group. 
%AI Length The number of discrete references that are to be included on this 

device. 

Analog Inputs - Secondary Bus  
When a dual bus is employed, there must be an alternate location for the analog inputs to 
report their values.  The alternate location is the reference area in which the inputs will appear 
while they are connected to the Secondary Genius I/O bus. 

Max-ON RX3i redundancy drivers detect when the Primary inputs are unavailable.  If the 
Secondary inputs are reporting into the Secondary reference area, the drivers will map the 
data automatically from the Secondary area into the Primary address locations.  This permits 
the user-application to be written with references to the Primary addresses only. 
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%AI Reference The first reference address used in the secondary (alternate) reference  
   table.  This value is read-only.  The reference will always be  
   equal to the Primary reference plus an offset of 1024. 

%AI Length  The number of discrete references that are to be included on this  
   device.  This is a read-only value that is generated from the number  
   that was entered for the Primary Bus. 

Circuit Configurations  
Analog input scaling may be used to convert raw values received from the input device into 
scaled values.  Because many bus devices are able to perform their own scaling, this option 
may be enabled for devices that do not provide scaling inherently.  Please be aware that 
enabling this option adds to overall scan time and consumes additional configuration memory. 

The circuit configuration parameters are as follows: 

Address The analog circuit reference.  This item is read-only. 

Scaling Enables scaling from raw units (RU) to engineering units (EU) for the 
corresponding analog input circuit. 

RU Lower The lowest raw count value (RU) that the analog circuit will produce. 

RU Upper The highest raw count value (RU) that the analog circuit will produce. 

EU Lower The desired lowest value expressed in the sensor’s measurement unit 
(EU). 

EU Upper The desired highest value expressed in the sensor’s measurement 
unit (EU). 

The acceptable range of values for any of the units is –32768 to +32767. 

If the raw value produced by the analog circuit is less than the RU Lower value OR if the 
value is greater than the RU Upper value, then an alarm will be generated for the analog 
circuit. 

Notes:  

▪ Many of the GE Fanuc analog input devices are capable of performing scaling 
independently.  It is better to use the built-in capabilities of the devices.  This will reduce 
the CPU scan time by eliminating the extra processing associated with the scaling 
function.  Also, it reduces the amount of configuration memory consumed. 

▪ If the device is configured to be on a dual bus, then the Secondary analog input addresses 
will be at the Primary address plus an offset of 1024.  For example, %AI00001 will have 
an associated Secondary address at %AI01025. 
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Configuring Genius Analog Outputs 
The Genius Device dialog allows you to configure Genius analog outputs.  The main purpose 
of this configuration is to identify the device and the circuit reference so that online status may 
be monitored.  Any offline/online activity will be reported in the Max-ON RX3i Alarm Table. 
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Configuring the Secondary Address 
On dual bus systems, discrete and analog inputs are mapped from the Primary bus 
controller’s buffers into the normal input reference tables. 

Inputs from the Secondary bus controller are placed into an alternate area and then the Max-
ON RX3i redundancy driver remaps the alternate states into the table area used by the 
Primary.  Remapping occurs whenever the device is detected as being present on the 
Secondary bus, but not present on the Primary.  (In most instances the data will be available 
on one of the busses, but not both.  The exception is for Remote 90-30 Genius drops, in 
which case, there are bus controllers on each bus.) 

Analog Inputs 
For analog inputs, the Secondary addressing is fixed at the primary’s address reference plus 
1024.  Thus an analog input circuit addressed at %AI00001 will have a Secondary address at 
%AI01025. 

Discrete Inputs 
For discrete inputs, the addressing is more flexible. 

▪ If the Primary address is on a word multiple (i.e. 1, 17, 33, etc.) AND the length is a word 
multiple (i.e., 16, 32, 48, etc.), then the Secondary address will be mapped into %R space. 

▪ If the primary address does not meet the criteria above, then the user may select an 
alternate address at either a %G reference or a %I reference. 

Secondary Bus References 
The configuration utility will display the configuration options for the Secondary bus references 
automatically.  Please use the configuration information displayed in the text window to obtain 
the information that is needed to configure the Secondary bus controllers for discrete and 
analog inputs. 
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Project Information 

Configuration Summary 
The configuration summary provides information about your project.  You determine the 
content of this report by the item that is selected in the project tree.  Each time an item is 
selected in the project tree, the configuration summary will update automatically. 

 

The configuration summary window text can be selected (use the Select All right mouse 
button), and pasted into a text editor for archiving and printing.
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User Defined Alarms  
The user may post user defined faults from within the application.  However, before the Max-
ON RX3i Diagnostics can display the user alarms, they must be configured. 

NOTE: User Defined Alarms are not available in the current version of the Max-ON RX3i 
Diagnostics. 

Adding a User Alarm 
1. Select the User Alarms item in the Max-ON RX3i Configuration Utility Project tree. 

 

2. Select the User Defined Alarms > Add Alarm… menu item. 

3. Enter an Alarm Number and the corresponding Alarm Description.  Note:  The Alarm 
Number must be within the numerical range 3840..4095.  The descriptor may be up to 
60 characters in length. 
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4. Enter any additional alarms. 

 

5. Save your Max-ON RX3i Configuration, update the cfg_dat C Block in the Max-ON 
Project. 

6. Download the new Max-ON RX3i Configuration to the CPUs. 
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Deleting a User Alarm 
1. Select the User Alarms item in the Max-ON RX3i Configuration Utility Project tree. 

2. Select a User Alarm by clicking on the gray button to the left of the User Alarm 
number. A “*” will be placed on the button to indicate it’s selection. 

3. Select the User Defined Alarms > Delete Alarm menu item. The alarm has now been 
removed. 

4. Repeat steps 2 and 3 for any additional user-defined alarms. 

5. Save your Max-ON RX3i Configuration, update the cfg_dat C Block in the Max-ON 
Project. 

6. Download the new Max-ON RX3i Configuration to the CPUs. 

Note: In order for User-Defined Alarms to be active, ladder logic must be added to the 
application.  The logic passes the user specified alarm number to the Alarm handler.  (See 
Max-ON RX3i Advanced Programming topic:  User-Defined Alarms.) 
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Programming Considerations 

This chapter provides additional information on programming considerations and system 
resources for the Max-ON RX3i product. In many cases, Max-ON RX3i System Variables 
have been predefined to use in application logic in order to interact with the Max-ON RX3i 
redundancy driver. 

Reserved References 
Max-ON RX3i redundancy drivers make use of a small number of variable references.  Some 
of these references are used for the internal operation of the drivers to hold system state 
information. Many are available to your application logic to provide both information on the 
system and to control the operation of the redundancy drivers. 

I/O References 
%I00001 to 2048 Available to all applications 
%Q00001 to 2048 Available to all applications 
%AI00001 to configured limit Available to all applications 
%AQ00001 to configured limit Available to all applications 
Boolean References 
%G00001 to 1024 Available to all applications 
%G01025 to 1280 Reserved by Max-ON RX3i 
%M00001 to 0928 Available to all applications 
%M00929 to 1024 Reserved by Max-ON RX3i 
%M01025 to 4096 Available to all applications 
%S (all) Available to all applications 
%T00001 to 256 Available to all applications 
Word References 
%R00001 to 8000 Available to all applications 
%R08001 to 16384 Reserved by Max-ON RX3i 
%R16385 to configured limit Available to all applications 
%W00001 to %W29999 Available to all applications 
%W30000 to %W50000 Reserved by Max-ON RX3i 

 

Chapter 

5 
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System Status Flags 
The System Status Flags indicate key operating characteristics of a Max-ON RX3i system.  
These flags may be monitored by an HMI to display such things as current Master.  
Optionally, the system designer may use the status flags to control the operation of the 
application. 

Variable 
Name 

Reference Description 

ID_A %M01017 ID Flag for CPU A 
ID_B %M01018 ID Flag for CPU B 
CPU_RUN %M01019 CPU is in RUN Mode 
MASTER %M01020 Master Flag 
SYNC_OK %M01021 All Data has been Synchronized 

 %M01022 – 
%M01024 

Reserved 

 

%M01017 ID Flag for CPU A (ID_A) – This flag is ON in the CPU identified as PLC A.  
(Setting the CPU Identity) 

%M01018 ID Flag for CPU B (ID_ B) – This flag is ON in the CPU identified as PLC B.  
(Setting the CPU Identity) 

%M01019 CPU is in RUN Mode (CPU_RUN) – This flag is ON if the CPU is in RUN 
Mode.  It is OFF if the CPU is in STOP/Disabled or STOP/Enabled. 

%M01020 Master Flag (MASTER) – This flag is ON in whichever CPU is the current 
Master. 

%M01021 All Data has been Synchronized (SYNC_OK) – This flag is always ON in the 
CPU identified as the current Master.  It is ON in the Backup CPU at the 
moment when all Synchronized Data items have been updated.  
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Indicating Mastership 
Using the System Status Flag %M01020 (Master) and the System Status Flags %M01017 
and %M01018 (the CPU Identity flags), you may determine which PLC is the current Master.  
By combining these flags it is possible to link discrete outputs to indicator lamps, link to 
internal coils to provide status points to an HMI, or even link discrete outputs to data switches 
to route communications lines from a peripheral to the CPU serial ports. 

In the example below, the Flags are used to control discrete outputs that are attached to 
indicator lamps. 

 

 

 

 

 

 

 

 

 

The next two rungs will indicate which CPU is Master.

ID_A

%M01017
This is CPU A

MASTER

%M01020
This CPU is

Master

A _M aster

CPU A  is the
Master

ID_B

%M01018
This is CPU B

MASTER

%M01020
This CPU is

Master

B_M aster

CPU B is the
Master
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Local Status Flags – Instantaneous 
The following status flags represent the instantaneous (not latched) state corresponding to the 
associated descriptors. 

Variable 
Name 

Reference Description 

AUTH_ALM %M00961 Authorization Alarm 
REM_OFF %M00962 Remote CPU Offline 
PROG_CHG %M00963 Program Changed 
HWC_CHG %M00964 HW Configuration Changed 
 %M00965 - 

%M00968 
Reserved 

 
%M00961 Authorization Alarm (AUTH_ALM) – This alarm bit indicates that the 

corresponding PLC is operating in DEMO mode on a standard PACSystems 
RX3i CPU (IC695CPU310).  In a system that has been properly authorized, 
this flag will be OFF. 

%M00962 Remote CPU Offline (REM_OFF)– The companion PLC is offline.  This may 
be due to the CPU being in STOP, Fault, or Power-OFF.  Also, it may be due 
to a cable problem or Ethernet Interface failure. 

%M00963 Program Changed (PROG_CHG) – The program in the Local CPU has  
changed. 

%M00964 HW Configuration Changed (HWC_CHG) – The hardware configuration in 
the Local CPU has changed. 
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Local Status Flags – Instantaneous (cont.) 
Variable 

Name 
Reference Description 

PWR_UP %M00969 Power Up 
PRG_RST %M00970 Program Restart 
E1_OFFL %M00971 System Ethernet Bus Primary Offline 
E2_OFFL %M00972 System Ethernet Bus Secondary Offline 
 %M00973 - 

%M00992 
Reserved 

 

%M00969 Power Up (PWR_UP) – The Local CPU has undergone a power-up event. 

%M00970 Program Restart (PRG_RST) – The Local CPU has been switched from 
STOP mode to RUN mode. 

%M00971 System Ethernet Bus Primary Offline (E1_OFFL) – The primary Ethernet 
LAN is offline.  This may be due to a cable problem, a transceiver problem, a 
hub/switch problem, an ETM001 module failure or a LAN configuration error. 

%M00972 System Ethernet Bus Secondary Offline (E2_OFFL) – The secondary 
Ethernet LAN is offline.  This may be due to a cable problem, a transceiver 
problem, a hub/switch problem, an ETM001 module failure or a LAN 
configuration error. 

%M00973 - Reserved 
%M00992 
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Local Status Flags – Latched 
The following status flags represent the latched state corresponding to the associated 
descriptors.  The states are set by the first instance of the associated event.  The flags are 
reset by either a Local Alarm Clear (RST_LOC or %M01015) or a Master Alarm Clear 
(RST_ALL or %M01016).  If the underlying alarm condition is persistent, then the flag will be 
set again. 

Reference Description 

%M00993 Authorization Alarm (A-Only) 
%M00994 Authorization Fault (A-Only) 
%M00995 Remote CPU Offline 

%M00996 Program Changed 
%M00997 HW Config Changed 
%M00998 Programs Miscompare 
%M00999 Reserved 
%M01000 Reserved 

 

%M00993 Authorization Alarm – This alarm bit indicates that the corresponding PLC is 
operating in DEMO mode on a standard PACSystems RX3i CPU 
(IC695CPU310).  When the CPU is replaced by a Max-ON cpu 
(IC695CMU310), this flag may be reset using the RST_LOC or RST_ALL 
variables.   

%M00994 Authorization Fault – This fault bit indicates that the system was operating in 
DEMO mode for over 22 days and has subsequently shutdown.  The PLC Fault 
Table will indicate shutdown due a Service Request. 

%M00995 Remote CPU Offline – The companion CPU is offline.  This may be due to the 
CPU being in STOP, Fault, or Power-OFF.  Also, it may be due to a cable 
problem or Ethernet Interface failure. 

%M00996 Program Changed – The program in the Local CPU has changed. 

%M00997 HW Config Changed – The hardware configuration in the Local CPU has 
changed. 

%M00998 Programs Miscompare – The program in CPU A is not the same as the 
program in CPU B. 
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Local Status Flags – Latched (cont.) 
Reference Description 

%M01001 Power Up 
%M01002 Program Restart 
%M01003 Max-ON Alarm (Fault) Present 
%M01004 Max-ON Alarm (Fault) Table Full 
%M01005 Config Fault 
%M01006 
– 
%M01008 

Reserved 

 
%M01001 Power Up – The Local CPU has undergone a power-up event. 

%M01002 Program Restart – The Local CPU has been switched from STOP mode to 
RUN mode. 

%M01003 Max-ON Fault Present – There is at least one fault entry in the Local CPU’s 
Max-ON Alarm Table. 

%M01004 Max-ON Fault Table Full – The Local CPU’s Max-ON Alarm Table is full. 

%M01005 Config Fault – The Max-ON configuration has exceeded one or more limits for 
the allowable size of Synchronized Data transfers. 

%M01006 - Reserved 
%M01008 
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Remote Status Flags - Latched 
The following flags indicate the status as received from the companion (remote) CPU.  For 
instance, if you are attached to CPU A in Logic Developer PLC, then these bits in CPU A will 
depict system status received from CPU B. 

The flags below are latched.  They may be cleared by resetting the alarms (see Command 
Flags).  If the alarm condition persists, then the flag(s) will be set again. 

Reference Description 

%M00929 Remote is Offline 
%M00930 Remote Forces (Overrides) Present 
%M00931 Remote PLC Low Battery 

%M00932 Remote Config Mismatch 
%M00933 Remote Loss of I/O Module 
%M00934 Remote Loss of Option Module 
%M00935 Remote Option Module Hard Fault 
%M00936 Remote Option Module Soft Fault 

 

%M00929 Remote is Offline – CPU is offline, or there has been a bus failure on a 
system that uses a single Ethernet Sync bus, or on a system using dual Sync 
busses, both have failed. 

%M00930 Remote Forces (Overrides) Present  – There is at least one force (override) 
present in the remote, same as #OVR_PRE (%S0011) in the remote. 

%M00931 Remote PLC Low Battery  – Same as #PLC_BAT (%S0014) in the remote. 

%M00932 Remote Config Mismatch  – Same as #CFG_MM (%SA0009) in the remote. 

%M00933 Remote Loss of I/O Module – Same as #LOS_IOM (%SA0014) in the remote. 

%M00934 Remote Loss of Option Module – Same as #LOS_SIO (%SA0015) in the 
remote. 

%M00935 Remote Option Module Hard Fault  – Same as #HRD_SIO (%SA0027) in the 
remote. 

%M00936 Remote Option Module Soft Fault – Same as #SFT_SIO (%SA0031) in the 
remote. 
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Remote Status Flags – Latched (cont.) 
Reference Description 

%M00937 Remote System Fault Present 
%M00938 Remote I/O Fault Present 
%M00939 Remote Max-ON Fault Present 
%M00940 Remote Max-ON Fault Table Full 
%M00941 Remote Program Changed 
%M00942 Remote HW Config Changed 

%M00943 Remote Power Up 
%M00944 Remote Program Restart 
%M00945 Remote Authorization Alarm 
%M00946 – 
%M00960 

Reserved 

 
%M00937 Remote System Fault Present – Same as #SY_PRES (%SC0012) in the 

remote. 

%M00938 Remote I/O Fault Present – Same as #IO_PRES (%S0013) in the remote. 

%M00939 Remote HBR Fault Present – there is at least one fault in the Max-ON fault 
table. 

%M00940 Remote HBR Fault Table Full – The Max-ON fault table is full. 

%M00941 Remote Program Changed – The user application in the remote has  
changed. 

%M00942 Remote HW Config Changed – The hardware configuration in the remote has 
changed. 

%M00943 Remote Power Up – The remote has undergone a power-up event. 

%M00944 Remote Program Restart – The remote has undergone a Program Stop-to-
Run event. 

%M00945 Remote Authorization Alarm –The Remote CPU is operating in DEMO mode. 

%M00946 - Reserved 
%M00960 
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System Command Flags 
Operation of the system may be influenced by interfacing to the Max-ON RX3i command 
flags.  They may be accessed within application logic, and in some instances by an HMI. 

Variable 
Name 

Reference Description 

SEL_A %M01009 Select A as Preferred 
SEL_B %M01010 Select B as Preferred 
SW_MSTR %M01011 Switch Master (self-resetting) 
AUT_SWP %M01012 Auto Sweep Mode 
 %M01013 Not used 
 %M01014 Clear Remote Alarms (self-resetting) 
RST_LOC %M01015 Clear Local Alarms (self-resetting) 
RST_ALL %M01016 Clear All Alarms (self-resetting) 

The definitions of the flags are as follows: 

%M01009 Select A as Preferred (SEL_A) - Used in conjunction with SEL_B (%M01010) 
to determine the manner in which Mastership operates.  (See Selecting the 
Master)  

%M01010 Select B as Preferred (SEL_B) - Used in conjunction with SEL_A (%M01009) 
to determine the manner in which Mastership operates.  (See Selecting the 
Master) 

%M01011 Switch Master (self-resetting) (SW_MSTR)  - Used to exchange Mastership 
(See Selecting the Master).  If it is set ON, the Max-ON driver will reset it to 
OFF automatically.  (See Switching the Master) 

%M01012 Auto Sweep Mode –When this is set to ON, the Backup CPU will be set to 
Constant Sweep mode automatically, and the Master will be set to Normal 
Sweep mode automatically.  (See PLC Sweep Mode.) 

%M01013 Not used. 

%M01014 Clear Remote Alarms (self-resetting) - When issued to the Master, CLEARS 
the alarms in the Backup CPU only.  If it is set ON, the Max-ON driver will reset 
it to OFF automatically. 

%M01015 Clear Local Alarms (self-resetting) - Clears the alarms in the CPU to which it 
is  directed. Is reset automatically. 

%M01016 Clear All Alarms (self-resetting) - When issued to the Master, CLEARS the 
alarms in the Master and Backup CPUs.  Is reset automatically. 
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Mastership Modes 
You may specify the Mastership mode of operation for the Hot Standby CPUs.  This may be 
accomplished by setting the states of the System Command Flags, SEL_A (%M01009) and 
SEL_B (%M01010).  Both CPUs must have the states set identically in order to function 
properly.  The truth table shown below illustrates the operation of the Mastership Command 
Flags. 

SEL_A 
%M01009 

SEL_B 
%M01010 

Description 

0 0 Float 
1 0 A Preferred 

0 1 B Preferred 
1 1 Float 

▪ A Preferred - In this mode, SEL_A (%M01009) is ON and SEL_B (%M01010) is OFF.  
Assume that CPU A is currently the Master.  If CPU A fails or is placed in STOP, then 
CPU B will become the new Master.  CPU B will remain the Master until CPU A is 
repaired or is restored to RUN mode.  As soon as the all of the Synchronized Data has 
been updated in CPU A, the Mastership will return to CPU A. 

▪ B Preferred - In this mode, SEL_A (%M01009) is OFF and SEL_B (%M01010) is ON.  
The description is similar to A Preferred, except that the roles are transposed. 

▪ Float - Either CPU may be the Master.  Mastership will not change unless the current 
Master fails or is placed into STOP or RUN-Outputs Disabled mode.  When the 
failed/stopped CPU is restored to service, the current Mastership does not change.  
While the system is in Float Mode, Mastership may be changed by setting the System 
Command Flag, SW_MSTR (%M01011).  Float Mode is required if you intend to 
switch Mastership using an HMI. 
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Setting the Master Using a Selector Switch 
A three position, center-OFF, selector switch may be connected to a pair of discrete inputs 
shared by the two CPUs.  This allows a system operator to chose either of the CPUs to be the 
Preferred Master, or the Mastership may float between the two controllers. 

In the example that follows, the switch contacts are wired to discrete inputs SEL_A (%I01009) 
and SEL_B (%I01010).  When the switch is in the A position, only SEL_A (%I01009) is ON.  
When the switch is in the B position, only SEL_B (%I01010) is ON.  When the switch is in the 
center (Float) position, SEL_A (%I01009) and SEL_B (%I01010) are both OFF. 

 

The next two rungs choose the preferred Master.

SSw_101A

%I01009
Selector

Switch Select
A

SEL_A

%M01009
Select A

Pref'd

SSw_101B

%I01010
Selector

Switch Select
B

SEL_B

%M01010
Select B
Pref'd
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Setting a Preferred Master 

You may set a permanent, Preferred Master.  In this mode, if the corresponding CPU fails (or 
is placed in STOP), then the companion CPU will assume Mastership.  As soon as the 
Preferred Master resumes operating normally, and its Synchronized Data has been updated, 
then the Mastership will transfer. 

The example shown below sets PLC A as the preferred master. 

 

 

Setting the System for Floating Master 
Set the system to Floating Master by including the logic shown below in your application.  
Include this logic in any system that must change mastership based upon a command 
initiated by either momentary pushbutton or HMI. 

The next two rungs set the Mastership Mode for"Float"

#ALW_OFF

%S00008
Always OFF

SEL_A

%M01009
Select A

Pref'd

#ALW_OFF

%S00008
Always OFF

SEL_B

%M01010
Select B
Pref'd

 

The next two rungs set the Mastership Mode for"Preferred A"

#ALW_ON 

%S00007 
Always ON 

SEL_A 

%M01009 
Select A 

Pref'd 

#ALW_OFF 

%S00008 
Always OFF

SEL_B

%M01010 
Select B 
Pref'd 
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Switching Mastership Using a Momentary Pushbutton 
You may switch Mastership using a momentary pushbutton switch that is wired to a discrete 
input shared by the Hot Standby CPUs.  In the example that follows, the switch is wired to 
discrete input Sw_Mstr_Pb (%I01011). When this input transitions from Off to On, the System 
Command Flag SW_MSTR (%M01011) will be set.  The system will reset SW_MSTR 
(%M01011) after it has completed processing the switchover. 

 
First, you must set the system for Floating Mastership.  (Refer to Setting the System for 
Floating Master.) 

Then include the following logic to implement the Toggle Master function. 

The next rung switches the Master. The system will reset %M1001 automatically.

Sw_Mstr_Pb

%I01011

SW_MSTR

%M01011
Switch

Master (os)

 

If a command to set SW_MSTR (%M01011) has been issued, then the system will operate in 
the following manner. 

▪ If both CPUs receive the command, and there is no Preferred Master, then the 
Mastership will change as soon as data synchronization is complete. 

▪ If only the Master receives the command, and the Backup is available, and there is no 
Preferred Master, and data synchronization is complete, then the transfer will occur. 

▪ If one or both of the CPUs receive the command, and the Master is the Preferred 
Master, then the request is discarded. 

▪ If only the backup receives the command, then no transfer will occur.  

▪ After the relevant conditions above have been evaluated, SW_MSTR (%M01011) will 
be reset automatically. 
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Switching Mastership Using an HMI 
In your HMI application, configure an operation that sets the command flag SW_MSTR 
(%M01011) in the current Master CPU.  The HMI should set SW_MSTR (%M01011) in each 
PLC.  This command will be executed in the current Master CPU, but will be ignored in the 
current Backup CPU.  Each CPU will reset the command automatically. 

 Assuming that there is no preferred Master set in either CPU, then the transfer will occur as 
soon as data synchronization is complete.  In most cases, this will happen immediately. 

You must set the system for Floating Mastership.  (Refer to Setting the System for Floating 
Master.)  No other logic is required. 

System Data Registers 
Variable Name Reference Function Description  
CAT_NUM %R9001 Catalog Number  
REV_NUM %R9002 Current Release Number integer with implied decimal point (e.g., +00101 = 

v1.01) 
USR_N1 %R9003 

%R9004 
User Version Number (double precision) If audit trail has been enabled, 

Max-ON will increment this register pair each time a 
program change is stored or updated.  If audit trail is 
not enabled, then the user may enter any value here. 

PDAT_01 %R9005 - mm:ss 
%R9006 - dd:hh 
%R9007 - yy:mm 

User Version Date Related to above...this is a packed BCD date. 
yy/mm/dd | hh:mm:ss 

 %R9008 
%R9009 

Program Size (double precision) An approximate program size.  
Some users include this value with the checksum 
value for additional security in revision control. 

 %R9010 Program Additive Checksum   
 %R9011 - 

%R9021 
Reserved  

 %R9022.. Not used   
 %R9023 Not used   
 %R9024 Not used   
REM_SCN %R9025 Remote CPU’s Current Scan 

time 
Instantaneous PLC Scan time in msec. 

LOC_SCN %R9026 Local CPU’s Current Scan 
time 

Instantaneous PLC Scan time in msec. 

LOC_MUX %R9027 Average Mux. Packet Interval Average time interval for advancing to the next 
multiplexer packet. (msec.) 

IOM_UPD %R9028 %S, %M, %Q, %AQ Update 
Interval 

Time to update all %S, %M, %Q, %AQ and time of 
day in the backup PLC (sec. X 0.01) 

REG_UPD %R9029 %R Update Interval Time to update registers in the backup PLC (sec. X 
0.01) 

NUM_FLT %R9030 Number of Faults in Fault 
Table 

0 = empty; 33 = full 

NUM_FLT[001] %R9031.. 
%R9036 

Fault Record #01   

NUM_FLT[007] %R9037.. 
%R9041 

Fault Record #02   

     …     …   
     …     …   
NUM_FLT[156] %R9186.. 

%R9190 
Fault Record #32   
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Advanced Topics  

PID Function Blocks 
The PID function block uses a data structure consisting of 40 registers.  These registers 
contain not only configuration parameters, but also intermediate and final terms used in the 
internal calculations.  Some of the internal calculations are based upon values from the PLC’s 
system clock.  Because the internal clocks in the two CPUs are not synchronized precisely to 
each other, it is necessary to include a small amount of logic to compensate for the difference. 

Also, it will be necessary to include the PID registers in one or more of the %R Synchronized 
Data Groups.  This ensures that the PID in the Backup CPU tracks the Master. 

The ladder logic is straightforward: 

 
 
 
 
 
 

The following rungs control the operation of the PID.

This first Rung allows the PID to be placed in Manual by an HMI or a local  control station.  This is accomplished by setting P01_Man (%M00501).
(Note  that %M00501 operates only in the Master CPU.  If P01_Man (%M00501) is SET in the Backup, then it will be reset before the 
rung containing the PID is solved.)

  If the PID is in Manual, then the raise P01_Up (%M00502) and lower P01_Dn (%M00503) contacts are operational.  If this is the Master CPU, 
then the output (CV) will respond to the UP/DN commands.

  If this is the Backup CPU, the register block (%R01001..01040) will be overwritten by Synchronized Data values received from the Master
CPU.  This forces the Backup's PID to "Track" the values in the Master.

MASTER

%M01020
This CPU is

Master

P01_Man

%M00501
PID_01: Set
in Manual

P01_Man

%M00501
PID_01: Set in

Manual

MASTER

%M01020
This CPU is

Master
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PID ISA

P01_SP

%R00501
PID_01:Set Pt

PID_P01

SP CV
%R01001
PID_01:
Paramet

ers

P01_CV

%R00503
PID_01: 
Output Value

P01_PV

%R00502
PID_01:Prese

t value

PV

P01_M an

%M00501
PID_01: Set in

Manual

MAN

P01_Up

%M00502
PID_01: Raise

Output

UP

P01_Dn

%M00503
PID_01:

Lower Output

DN

 
 
In this example, the PID parameters begin at PID_P01 (%R01001).  For PID loop 01, there 
must be a synchronized data group configured that assures that registers %R01001 through 
%R01040 are transferred.  You must include the registers associated with other PID function 
blocks as well. 
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User-Defined Alarms 
The user may post self-defined faults from within the application by performing the following 
steps. 

Note: User defined Alarms are not available in this version the Max-ON RX3i VIEW 
Diagnostic Tool. 

In Max-ON RX3i Configuration Utility 
1. Select the User Alarms item in the Max-ON RX3i Configuration Utility Project tree. 

 

2. Select the User Defined Alarms > Add Alarm… menu item. 

3. Enter an Alarm Number and then the corresponding Alarm Description.  Note:  The 
Alarm Number must be within the numerical range 3840..4095.  The descriptor may be 
up to 60 characters in length. 
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4. Enter any additional alarms. 

 

5. Save your Max-ON RX3i Configuration, update the cfg_dat C Block in the Max-ON 
Project. 

6. Download the new Max-ON RX3i Configuration to the CPUs. 
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In Your Application Folder 
1. Move a user specified fault value into FLT_COD (%R9762).  The fault value must be in 

the range 3840..4095 (decimal) inclusive, and should correspond to the equivalent 
user-defined fault created in Max-ON RX3i Configuration Utility. 

2. In most cases, move a value 0 into FLT_CKT (%R9761).  However, you may define 
your own identifier that may be MOVed into this register.  The diagnostic tool will 
display this as a decimal value in the Circuit Reference position. 

3. Call the subroutine named HBR_005.  This must be done for only once, otherwise 
each subsequent call will post an additional alarm into the alarm table.  In the sample 
logic shown below, ua_0002 (%M02050) has been used as an alarm latch.  The user-
defined alarm will be posted only if the coil is not already set.  Note that a setcoil is 
used so that the alarm state will be retained through a loss of power.  Also, a rung has 
been provided that resets the coil if the alarm clear flags are invoked. 

Process a User A larm

PSH_1402

%I00259
Pump

Discharge
Pressure High

ua_0002

%M02050
User_0002:P1

402 High
Pressure
Alarm

MOVE
INT

MOVE
INT

CA LL
hbr_005

ua_0002

%M02050
User_0002:P1

402 High
Pressure
A larm

0

1

IN Q FLT_CKT

%R09761
Fault Parm: 
Ckt Number

3841

1

IN Q FLT_COD

%R09762
Fault parm: 
Fault Code

RST_A LL

%M01016
Reset A ll

A larms (os)

ua_0002

%M02050
User_0002:P1

402 High
Pressure
A larm

RST_LOC

%M01015
Reset Local
A larms (os)
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If a corresponding user-defined alarm has been entered during the Max-ON RX3i 
Configuration Utility configuration session, then the fault time-stamps, along with 
appropriate descriptors will be displayed in the Max-ON RX3i Alarm Table in the Proficy 
View Diagnostics application. 

Max-ON RX3i variables used by subroutine HBR_005 to log a user defined alarm. 

Variable Name Reference Description 

FLT_CKT %R09761 Fault Parameter: Circuit Number 
FLT_COD %R09762 Fault Parameter: Fault Code 
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Alarm Table Organization  

The Alarm Table begins at %R9030 and ends at %R9190.  The Alarm Table organization is 
shown below.   

Variable Name Register Description 

NUM_FLT %R9030 Number of Faults in Table (0 = empty; 33 = full) 
NUM_FLT[001] %R9031 Record 1 – Fault Type 
NUM_FLT[002] %R9032 Record 1 – Fault Location 
NUM_FLT[003] %R9033 Record 1 – Time Stamp 
NUM_FLT[004] %R9034 Record 1 – Time Stamp 
NUM_FLT[005] %R9035 Record 1 – Time Stamp 
NUM_FLT[006] %R9036 Record 2 - Fault Type 
NUM_FLT[007] %R9037 Record 2 - Fault Location 
 … … 
NUM_FLT[156] %R9186 Record 32 - Fault Type 

The value in NUM_FLT (%R09030) indicates the number of active faults (alarms) in the table.  
A value of zero indicates that the fault table is empty.  A value of 33 indicates that the table is 
full.  When the table is full, no further faults may be added to the table. 

The first fault table entry is located in NUM_FLT[001..005] (%R9031..9035).  The second fault 
entry is in NUM_FLT[006..010] (%R9036..9040).  This pattern is repeated for a total of 32 
fault records. 

Alarm Record Structure  

Each record in the Alarm Table consists of 5 registers.  Each register may be interpreted as a 
pair of bytes whose definitions are shown in the table below.  If the registers are displayed as 
hexadecimal values in Logic Developer PLC, then the interpretation may be simplified.   

Byte Offset Description 

0 Timestamp:  Seconds (BCD) 
1 Timestamp:  Minutes (BCD) 
2 Timestamp:  Hours (BCD) 
3 Timestamp:  Day of Month (BCD) 
4 Timestamp:  Month (BCD) 
5 Timestamp:  Year (BCD) 
6 Circuit Reference - lsb 
7 Circuit Reference - msb 
8 Alarm Subclass 
9 Alarm Class 

Bytes 0..5 These contain date and time information stored as BCD values.  The simplest 
way to view these in Logic Developer PLC is to display the fault table registers as 
hexadecimal numbers. 
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Bytes 6..7 Bytes 6 and 7 contain the decimal value of an I/O circuit reference. The value in 
this pair of bytes must be interpreted in the context of the Alarm Class that has 
generated the message.  The Alarm Class is contained in Byte 9. The value will 
be zero for CPU or system-level hot standby faults. 

Byte 8 This byte contains the Alarm Subclass code.  The subclass contains the rack 
number in the upper nibble and the slot number in the lower nibble. This number 
implies different fault descriptions depending upon the value of the Alarm Class 
contained in byte 9. 

Byte 9 This byte contains the Alarm Class code.  The valid range is 0000..4095. 

Alarm Class 

(Offset 9) 

Alarm 
Subclass 

(Offset 8) 

Circuit Reference 
Range (Integer) 

(Offset 6/7) 

Alarm Class Description 

00 00..FF Always 0 System level faults 
01 00..FF 0001..2048 Discrete input circuit 
02 00..FF 0001..2048 Discrete output circuit 
03 00..FF 0001..1024 Analog input circuit 
04 00..FF 0001..0256 Analog output circuit 
05 00..FF 00..31 I/O LAN device 

06..0E 00..FF - - - Not defined 
0F 00..FF -32768..32767 User-defined  
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Alarm Class 00h - System Level Alarms 
Decimal 

Code 
Hex 

Code 
Description  

001 0001 CPU Stopped The CPU identified in the Source Column has transitioned from Run to 
Stop. 

002 0002 Program Restart The CPU identified in the Source Column has transitioned from Stop to 
Run. 

003 0003 Power Up Power has been restored to the CPU identified in the Source Column 
004 0004 Invalid CPU ID The CPU identified in the Source Column does not have a valid ID.  

Open the hardware configuration.  Zoom into the CPU module and set 
the Checksum Length to 11 for CPU A or 12 for CPU B. 

005 0005 Duplicate IDs The CPUs have identical IDs.  Verify that the hardware configuration 
has been stored to the proper CPUs.  Verify the identities in the project 
have been set so that the Checksum Length for CPU A is 11 and 12 for 
CPU B. 

006 0006 New Authorization Not used. 
007 0007 Authorization Alarm This occurs after operating for a total of approximately 22 days in Demo 

mode. 
008 0008 Authorization Fault This occurs after operating for a total of approximately 22 days in Demo 

mode. 
009 0009 Authorization 

Corruption 
Not used. 

010 000A Program Changed The application program in the identified CPU has changed either due 
to a program store or due to online editing. 

011 000B HW Config Changed The hardware configuration in the identified CPU has changed. 
012 000C Program Checksum 

Mismatch 
There is a discrepancy between the checksum in CPU A and CPU B.  
This implies that the programs in the two CPUs are not equivalent.  

013 000D Remote is Offline The companion CPU has transitioned to an Offline mode. 
014 000E Remote is Online The companion CPU has transitioned to an Online mode. 
015 000F Local Switches to 

Master 
The CPU identified in the Source Column has become a Master. 

016 0010 Local Switches to 
Backup 

The CPU identified in the Source Column has become a Backup. 

017 0011 Genius Sync P Failure Not used. 
018 0012 Genius Sync S Failure Not used. 
019 0013 Genius Sync P LRC 

Error 
Not used. 

020 0014 Genius Sync S LRC 
Error 

Not used. 

021 0015 %Q Configuration Fault A defective configuration has been entered.  There are either too many 
%Q groups, or the reference range exceeds the capacity of the system.

022 0016 %AQ Configuration 
Fault 

A defective configuration has been entered.  There are either too many 
%AQ groups, or the reference range exceeds the capacity of the 
system. 

023 0017 %M Configuration 
Fault 

A defective configuration has been entered.  There are either too many 
%M groups, or the reference range exceeds the capacity of the system.

024 0018 %R Configuration Fault A defective configuration has been entered.  There are either too many 
%R groups, or the reference range exceeds the capacity of the system.
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Decimal 
Code 

Hex 
Code 

Description  

025 0019 Corrupted Config A defective configuration has been entered. 
026 001A Ethernet 

Synchronization 
Primary Failure 

The System’s primary Ethernet LAN has failed.  CPU A and CPU B are 
unable to transfer Synchronized Data via the primary Ethernet LAN. 

027 001B Ethernet 
Synchronization 
Secondary Failure 

The System’s secondary Ethernet LAN has failed.  CPU A and CPU B 
are unable to transfer Synchronized Data via the secondary Ethernet 
LAN. 

028 001C Illegal Mastership State There are either two Masters or two Backups in operation. 
029 001D Not used  
… … …  
032 0020 Not used  
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  Fault Class 01h - Discrete Inputs 
Decimal 

Code 
Hex 

Code 
Description  

257 0101 Circuit Offline The discrete input reference displayed in the Source 
Column has transitioned to an offline state. 

258 0102 Not used  
259 0103 Remote Rack Offline The remote drop corresponding to the discrete input 

reference displayed in the Source Column has transitioned 
to an offline state. 

260 0104 Remote Rack Overrides Present The corresponding remote drop has I/O overrides present.
261 0105 Remote Rack PLC Low Battery The corresponding remote drop has an indication of low 

CPU Battery voltage.  Replace or connect the battery in the 
remote drop. 

262 0106 Remote Rack Config Mismatch There is a configuration discrepancy between the modules 
installed in the remote rack and the hardware configuration 
that has been stored into the remote rack. 

263 0107 Remote Rack Loss of I/O Module An I/O module in the remote rack has failed. 
264 0108 Remote Rack Loss of Opt Mod  
265 0109 Remote Rack Opt Mod Hard Fault  
266 010A Remote Rack Opt Mod Soft Fault  
267 010B Remote Rack Sys Fault Present  
268 010C Remote Rack I/O Fault Present  
269 010D Remote Rack Program Changed  
270 010E Remote Rack HW Configuration 

Changed 
 

271 010F Remote Rack Power Up Power has been lost and then subsequently restored at the 
remote rack. 

272 0110 Remote Rack Program Restart The remote rack has transitioned from STOP to RUN. 
273 0111 Remote Rack Gen Bus P LRC  
274 0112 Remote Rack Gen Bus S LRC  
275 011D Not used  
… … …  
288 0120 Not used  
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Fault Class 02h - Discrete Outputs 
Decimal 

Code 
Hex 

Code 
Description  

513 0201 Circuit Offline The device corresponding to the circuit reference number shown in the 
Source Column has transitioned to offline. 

514 0202 Not used  
… … …  
544 0220 Not used  

 
Fault Class 03h - Analog Inputs 
Decimal 

Code 
Hex 

Code 
Description  

769 0301 Circuit Offline The device corresponding to the circuit reference number shown in the 
Source Column has transitioned to offline. 

770 0302 Not used  
771 0303 Under-range After scaling, the resulting value is less than the lower engineering unit 

limit. 
772 0304 Over-range After scaling, the resulting value is greater than the upper engineering 

unit limit. 
773 0305 Not used  
… … …  
800 0320 Not used  

 
Fault Class 04h - Analog Outputs 
Decimal 

Code 
Hex 

Code 
Description  

1025 0401 Circuit Offline The device corresponding to the circuit reference number shown in the 
Source Column has transitioned to offline. 

1026 0402 Not used  
… … …  
1055 0420 Not used  

Fault Class 05h – I/O LAN Alarms 
Decimal 

Code 
Hex 

Code 
Description  

1089 0501 Addition of Device The device corresponding to the circuit reference number 
shown in the Source Column has transitioned to online. 

1090 0502 Loss of Device The device corresponding to the circuit reference number 
shown in the Source Column has transitioned to offline. 

1091 0503 Not used  
… … …  
1120 0520 Not used  
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Configuring the Hot Standby Redundancy CPUs 

A Max-ON RX3i Project contains three Targets that are used to distinguish between hardware 
configurations for CPU A and CPU B, and the user application that is common to both of the 
CPUs.  The figure shown below illustrates the various components contained in the Generic 
X3i Project named Max-ON RX3i LD Project vx_yy.zip. 

 

When a Max-ON RX3i project is created, a hardware configuration Target is provided for PLC 
A and one is provided for PLC B.  In most aspects, these targets are very similar to each 
other.  The significant differences between the two hardware configurations are: 

•  Identity settings for the CPUs (via logic checksum words) 

•  Serial communication port settings and SNP ID  

•  Ethernet interface IP addresses  

•  Ethernet Global Data configuration for the Ethernet Sync LANs 

•  Ethernet Global Data configuration for the Ethernet I/O LANs 

•  Genius bus controllers configuration 

Many of the configuration items are completed during the process of developing the Project.  
The following sections provide details on the configuration of these elements. 

Chapter 

6 
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Configuring PLC A 

Open the Hardware Configuration for PLC_A_HW 
In the Max-ON RX3i Project, select and expand the Hardware Configuration node of the 
PLC_A_HW target. 

 

Set the Max-ON RX3i Identity for PLC A 
The identity for CPU A is determined by the value set in the Logic Checksum Words CPU 
parameter located in the CPU’s Hardware Configuration for CPU A.   

Open the CPU module’s Hardware Configuration by double-clicking on the IC695CMU310 
module.  

Click on the Scan tab to display the Logic Checksum Words parameter.   

Verify that the Logic Checksum Words parameter value is 32. If it is not 32, change the 
parameter to this value. 

Verify that the Number of Last Scans is set to 1. If it is not 1, change the parameter to this 
value. 
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Set Memory Limits for PLC A 
The Max-ON RX3i drivers have memory requirements as defined below: 

%W  

Registers 

%R  

Registers 

%AI  

Analog In 

%AQ  

Analog Out 

50000 
(minimum) 

16384 
(minimum) 

2048 
(minimum) 

512 (minimum) 

Select the Memory tab of the CPU configuration and verify that these values have been 
configured. Please note the memory limits may be larger than these values for use in your 
application. 
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Configure Ethernet Sync Network for PLC A 
Use the Sync LAN Interface Module configuration summary from the Max-ON RX3i 
Configuration Utility as a guide for configuring the Ethernet synchronization interfaces in the 
system. 

 
 

Add the Ethernet Interface module(s) to the appropriate slot(s) in the Hardware Configuration 
for PLC A and configure its parameters to match the Max-ON RX3i Configuration Summary. 
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Configure EGD Exchanges for Sync LANS for PLC A 
Critical system data is transferred between the PLCs by way of Ethernet Global Data 
Exchanges.  A Max-ON project contains two preconfigured sets of exchanges for each PLC 
(one for the Primary LAN and one for the Secondary LAN.) 

Single Sync LAN 
If you are not using a Secondary LAN, then delete the Consumed Exchange named 
MxnCons2 and also the Produced Exchange named MxnProd2. 
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Producer ID Modifications 

It might be necessary to revise the EGD configurations to match your unique system 
requirements (such as the IP addresses used.)  The local producer ID may be configured by 
clicking on Ethernet Global Data and then setting the appropriate properties within the 
Inspector window. 
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If the IP address needs to be changed, then you must also change the IP addresses in the 
Produced and Consumed Exchanges that follow. 

PLC A – Primary PLC A – Secondary 

  

  

 

Note:  All Ethernet modules within a PLC that produce and consume Ethernet Global Data 
must use the same Producer ID (i.e., IP address.)  For instance, all the modules in PLC A that 
are configured for EGD exchanges might be addressed at IP 100.100.100.1, while all those in 
PLC B are configured for 100.100.100.2.  This applies to Ethernet modules used for I/O 
networking as well. 
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Exchange References 
The tables that follow contain the references that are associated with the exchanges.  You 
may configure these parameters by double-clicking on the Produced or Consumed exchanges 
and then edit the values within the InfoViewer pane.  Note:  These parameters must be set 
exactly as shown. 

MxnProd1 (Primary LAN) 

Offset (Byte.Bit) Variable Ref Address Ignore Length Type 

Status  %W49619  1 WORD 

0.0  %W40001  76 WORD 

MxnCons1 (Primary LAN) 

Offset (Byte.Bit) Variable Ref Address Ignore Length Type 

Status  %W49620  1 WORD 

TimeStamp  %W49621  4 WORD 

0.0  %W40077  76 WORD 

 

MxnProd2 (Secondary LAN) 

Offset (Byte.Bit) Variable Ref Address Ignore Length Type 

Status  %W49629  1 WORD 

0.0  %W40001  76 WORD 

MxnCons2 (Secondary LAN) 

Offset (Byte.Bit) Variable Ref Address Ignore Length Type 

Status  %W49630  1 WORD 

TimeStamp  %W49631  4 WORD 

0.0  %W40153  76 WORD 
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Configure Ethernet Interface for Ethernet I/O LANS for PLC A (if used) 
Configure the Ethernet Interfaces used in conjunction with the Ethernet NIUs. Add the 
Ethernet Interface module(s) to the appropriate slot(s) in the Hardware Configuration for PLC 
A. You will also need to configure this Module’s EGD information to match the definitions of 
your ENIU EGD exchanges. 

 

Please note that only 4 Ethernet Modules may be added to an RX3i Main Rack. 

 

Configure Genius Bus Controllers for PLC A (if used) 
Use the Genius Bus Primary/Secondary configuration summary from the Max-ON RX3i 
Configuration Utility as a guide for configuring the Genius busses in the system. 
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Add the Genius bus controllers to the appropriate slot(s) in the Hardware Configuration for 
PLC A and configure its parameters to match the Max-ON RX3i Configuration Summary. 

 

Serial Bus Address (SBA) 
All Genius bus controllers in PLC A must be configured to have their serial bus addresses set 
at 31. 

Inputs Default 
Inputs should be set to Force OFF. 

Status Reference Type 
The recommended practice is set the device status address at the high end of the discrete 
input status references.  For instance, the first GBC might start at %I02017, length 32. 

Output at Start 
Outputs must be set to Disabled at Start. 
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Configure I/O Devices on the Primary Bus for PLC A 
Use the Bus I/O configuration summary from the Max-ON RX3i Configuration Utility as a 
guide for configuring the Genius devices that reside on the Genius bus.  

Add Genius devices to the GBC’s configuration and configure the Genius device parameters 
to match. A sample is shown below. 

 

 

Repeat this process for each Genius device in the Max-ON RX3i configuration. 

 
 

Repeat the above process until there are no more bus controllers to be configured. 

 

Note:  VersaMax I/O is no longer configured automatically by the PLC Max-ON drivers.  
Please make certain that you use the Remote I/O Manager in Machine Edition to set and 
download the configurations. 

 

If there are no Secondary busses in the system then store the configuration into CPU A.  
Otherwise, configure the secondary bus as explained next. 
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Configure I/O Devices on the Secondary Bus for PLC A 
Use the Bus I/O configuration summary from the Max-ON RX3i Configuration Utility as a 
guide for configuring the Genius devices that reside on the Secondary Genius bus. 

 

You can use the Copy Genius Bus function in the hardware configuration to facilitate the 
speedy duplication of Genius bus configurations. 

 

Select the location for the duplicate Genius Bus and an exact copy will be made to the 
destination slot location. 

 



 
                                                                                  

GFK-2409A Chapter 6  Configuring the Hot Backup CPUs 6-13 
 

6    

Configuring PLC B  

Open the Hardware Configuration for PLC_B_HW 
In the Max-ON RX3i Project, select and expand the Hardware Configuration node of the 
PLC_B_HW target. 
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Set the Max-ON RX3i Identity for PLC B 

The identity for CPU B is determined by the value set in the Logic Checksum Words CPU 
Parameter located in the CPU’s Hardware Configuration for CPU B.   

Open the CPU module’s Hardware Configuration by double-clicking on the CMU310 module.  

Click on the Scan tab to display the Logic Checksum Words parameter.   

Verify that the Logic Checksum Words parameter’s value is 16. If it is not 16, change the 
parameter to this value.  

Verify that the Number of Last Scans is set to 1. If it is not 1, change the parameter to this 
value. 

 

Set Memory for PLC B 
Normally, the memory in CPU B is configured the same as for CPU A.  Please refer to the 
information used for CPU A, and make adjustments to the CPU B memory configuration, if 
necessary.  

Configure Ethernet Sync Network for PLC B 
Repeat the configuration process for the Ethernet synchronization interfaces in PLC B. 
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Configure EGD Exchanges for Sync LANS for PLC B 

Repeat the configuration process for the Ethernet synchronization interfaces in PLC B. 

As stated for PLC A, if the IP address needs to be changed, then you must also change the IP 
addresses in the Produced and Consumed Exchanges that follow. 

PLC B – Primary PLC B – Secondary 
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Configure Ethernet Interface for Ethernet I/O LANS for PLC B (if used) 

Configure the Ethernet Interfaces used in conjunction with the Ethernet NIUs. 

Configure Genius Bus Controllers for PLC B (if used) 
Serial Bus Address 
All Genius bus controllers in PLC B should be configured to have their serial bus addresses 
set at 30. 

Input Default 
Inputs should be set to Force OFF. 

Status Reference Type 
The recommended practice is set the device status address at the high end of the discrete 
input status references.  For instance, the first GBC might start at %I02017, length 32. 

Output at Start 
Outputs must be set to Disabled at Start. 
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Configure I/O Devices on the Primary and Secondary Busses for 
PLC B 
The I/O devices in CPU B are configured exactly the same as for CPU A.  Please refer to the 
instructions earlier in this chapter to complete their configuration. 

Copying PLC A Configuration to PLC B Configuration 
A productivity tool that can also be used to speed the duplication of the Hardware 
Configuration between PLC A and PLC B is to Export the Hardware Configuration from PLC A 
and Import it into PLC B. This will accelerate the configuration of the hardware configuration 
and you only need to modify the slight differences in PLC B. 

To export the Hardware Configuration from the PLC_A_HW target and import it into the 
PLC_B_HW target: 

Select the Hardware Configuration node for PLC_A_HW target. 

Select the Export to File… right mouse menu item. 

 

Specify a file name for the configuration, or use the default name PLC_A_HW.hwc. 
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Select the Hardware Configuration node for PLC_B_HW target. 

Select the Import from File… right mouse menu item. 

 

Specify the file name used in Step 3 (default name PLC_A_HW.hwc). 

 

Now modify the Hardware Configuration for PLC_B_HW Target to match the parameters of 
PLC B in your system. 
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Configuring the I/O Devices 

Configuring the Ethernet I/O Devices 
Before you may use your system, you must configure the Ethernet I/O devices that are to be 
installed on the Ethernet I/O bus. For Max-ON RX3i the Ethernet devices may consist of 
PACSystems RX3i ENIUs and/or Series 90-30 ENIUs. 

For a complete description of how to configure and use the PACSystems RX3i ENIUs, please 
see GFK-2434, titled PACSystems RX3i Ethernet Network Interface Unit. A summary of the 
process to configure this ENIU is as follows: 

1. Determine the IP Addresses for the Primary (PLC A) and Secondary (PLC B) 
Controllers and the Ethernet NIU. 

2. Add the PACSystems ENIU target(s) to your Machine Edition Project by selecting the 
Add Target > GE Fanuc Remote I/O > PACSystems RX3i Ethernet menu. 

 
3. Set the IP Address and Subnet Mask on the Ethernet Transmitter module(s) ETM001 

in the Ethernet NIU target, Set Gateway IP Address if required. 
4. Set the Ethernet Global Data Local Producer ID in the Ethernet NIU. 
5. Add the input and output modules to the Ethernet NIU configuration. If you add or 

change modules later in the project, EGD Exchanges in the ENIU and controller may 
need to be updated. 

6. Complete the Ethernet Global Data Exchanges for the ENIU. 
7. If the ENIU has any Local Logic, develop this logic for the ENIU target. The RX3i 

Ethernet NIU allows the addition of up to 20K bytes of logic to be executed locally in 

Chapter 

7 
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the I/O Station. A LD logic block named “Local User Logic” is provided for this 
purpose.   

8. Repeat steps 2 through 7 for each ENIU. 
9. Store this information to each ENIU. 
10. Add the Ethernet Global Data component to the Primary (PLC_A_HW target) and 

Secondary (PLC_B_HW target) Controllers. 

 
11. Set the EGD Local Producer ID in the controllers. 
12. Create EGD Exchanges in the Primary controller (PLC A) to match the EGD 

exchanges in each ENIU. 
13. Create EGD Exchanges in the Secondary controller (PLC B) to match the EGD 

exchanges in each ENIU. 
14. If Remote COMMREQ Calls will be used with the ENIUs, add the RCC Parameterized 

C Block to the PLC_COMMON_CODE target’s application, and add any logic needed 
to execute these commands. 

15. Store the Hardware Configurations (PLC_A_HW and PLC_B_HW targets) to PLC A 
and PLC B. 

16. Store the Application Logic (PLC_COMMON_CODE target) to PLC A and PLC B. 
17. Verify that the EGD Exchanges are working. 
18. Verify that any RCC commands are working. 
19. Verify that any Local Logic is working. 
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Configuring the Genius I/O Devices 
Before you may use your system, you must configure the Genius I/O devices that are to be 
installed on the Genius I/O bus. 

You must configure each device for: 

•  Serial Bus Address (SBA) 
•  Type of I/O (Input, Output, Combination) 
•  Scaling 
•  Defaults 

Additionally, you must set the I/O to operate properly for redundancy: 

•  Dual I/O busses 
•  Hot Standby controller 

Genius and Field Control I/O  
While you are configuring the Genius I/O, you must configure extra parameters that govern 
system operation with respect to redundant PLCs and redundant (dual) Genius I/O busses.  
Please note that for Genius and Field Control I/O, you must have a Handheld Monitor 
available to set these parameters. 

Redundant Controllers 
Using the Genius Handheld Monitor (HHM), set each Genus device for Redundant Controllers 
= YES. 

BSM Present 
Using the Genius Handheld Monitor (HHM), set the BSM Present configuration parameter to 
YES.  This is required whether or not a dual Genius I/O bus is being used. 

When this parameter is configured as YES, then the output default period is extended from 3 
token rotation time periods to 2.5 seconds.  The extra time allows the RX3i PLCs to exchange 
mastership correctly. 

BSM Controller 
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If the Genius I/O device is attached directly to a dual bus, either by a Bus Switching Module 
(BSM) or a Bus Interface Unit (BIU), then you must configure this device to be a BSM 
Controller. 

Genius Block with BSM 
In the case of a Genius Block connecting to the BSM, setting the block to be a BSM Controller 
allocates its first output to the control of the BSM.  It is assumed that the BSM is connected to 
the first output circuit. 

In the case of Field Control connecting to the BIU, setting the parameter to be a BSM 
Controller directs the BIU to activate its internal bus switching circuitry. 

If the device is connected to a “stub” downstream of another device that controls the 
switching, then set BSM Controller to NO. 

Genius VersaMax I/O 
1. Add the PACSystems VersaMax target(s) to your Machine Edition Project by selecting 

the Add Target > GE Fanuc Remote I/O > VersaMax Genius menu. 

 

2. Click on the Target and rename it to match your application conventions. 

3. Expand the Hardware Configuration and then click on the Genius NIU component 
(IC200GBI001) 

4. Set the following parameters: 

Serial Bus Address: Set this in accordance with the addressing scheme for 
your project. 

Baud Rate: Normally this is set to 153.6 kbps Standard, however it 
may require adjustment depending upon cable 
selections, distances and the presence of electrical 
noise. 

BSM Present: Set this to Yes 
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BSM Controller: Set this to Yes if there are two Genius busses that 
connect directly to the NIU.  Set this to No, if there is a 
single bus connection. 

Output Time Default: Normally this is set to 2.5 Seconds 

CPU Redundancy: Set this to Hot Standby. 

 

5. Select this as the active target. 

6. Set the Comm port characteristics. 

7. Connect a serial programming cable to your workstation and to the VersaMax I/O 
drop. 

8. Store the configuration into the drop. 

9. Repeat this for any other VersaMax I/O drops in the system. 
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Remote 90-30 Genius Drops 
A Remote 90-30 Genius Drop consists of a Series 90-30 CPU, power supply, base, and one 
or more Genius bus controllers.  Input and output modules are installed in the CPU base.  
Modules also may be installed in an I/O Expansion base. 

A Scanner routine executes in the drop’s CPU.  This routine scans all input devices and 
transmits the input states to the Hot Standby PLCs by way of the I/O bus. 

Creating the Remote 90-30 Genius Drop Project 
Follow these steps to create a Remote 90-30 Genius Drop Project in Proficy Logic Developer 
PLC: 

1. Create a new project based on the appropriate Remote 90-30 Genius Drop template. 
The Remote 90-30 Genius Drop project is added to the Machine Edition project 
Navigator by using the File > Restore Project…  menu item.  Select the Project 
Navigator window making certain that there is no project open at this time. 

 

2. Using the File menu, click on Restore Project...  
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3. Navigate to the Proficy Components directory, then to the Remote Drops LD 
directory.  Open the desired Remote Drop directory, RemoteDrop CPU35x, 36x, 374 
(small), for example. Make certain that the selection for Files of Type has been set to 
Proficy Machine Edition (*.zip). Select the Remote Drop project backup file. 

 

 
 

 
 

When you click on Open, a new project will be added to the Proficy Navigator window. 

4. Give your project a descriptive name in the Machine Edition Navigator. 
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Remote Drop Status Word 
A remote drop always places important status information into its local references at %I00001 
through %I00016 inclusive.  The definition of these inputs is shown in the table below. 

Bit Offset Description 

1 Offline 
2 Overrides Present 
3 PLC Low Battery 
4 Config Mismatch 
5 Loss of I/O Module 
6 Loss of Option Module 
7 Option Module Hard Fault 
8 Option Module Soft Fault 
9 System Fault Present 
10 I/O Fault Present 
11 Program Changed 
12 HW Config Changed 
13 Power Up 
14 Program Restart 
15 Bus 1 LRC Error 
16 Bus 2 LRC Error 

To ensure proper operation of the remote drop, you must not configure any local module such 
that it overlaps these discrete input addresses.  Make certain that addressing for your 
modules begins at %I00017 or above. 
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Configuring the Drop’s GBC 
The Genius bus controller in the remote drop must be configured to transmit the input data to 
the Hot Standby PLCs and also to receive global data from the Hot Standby PLCs.  In the 
Remote Drop, global data contains the discrete and analog output data. 

Primary Bus 
The Genius bus controller should be configured as follows: 

In the Settings Tab 
Serial Bus Address (SBA): Any address from 0 to 29 is acceptable.  (Note:  Normally a 

Genius Handheld Monitor normally is set for SBA=0.  It is 
standard practice to avoid 0 when using Field Control or 
Genius I/O.) 

Status Reference Type: %I00481 for M23, M31, and M40 drop folders 
 %I02017 for M5S and M5L drop folders 

In the Global Data Tab 
At the GBC’s Address: 

Input 1 Address %I00001 
Input 1 Length always 0 
Input 2 Address %AI00001 
Input 2 Length always 0 
Output 1 Address %I00001 
Output 1 Length 16 plus the number of Discrete Inputs installed 
Output 2 Address %AI00001 
Output 2 Length The number of Analog Inputs installed 
 

At SBA 30: 

Input 1 Address See Buffer Registers 
Input 1 Length 62 
Input 2 Address %AI00001 
Input 2 Length always 0 
Output 1 Address %Q00001  
Output 1 Length always 0 
Output 2 Address %AQ00001 
Output 2 Length always 0  
 

At SBA 31: 

Input 1 Address See Buffer Registers 
Input 1 Length 62 
Input 2 Address %AI00001 
Input 2 Length always 0 
Output 1 Address %Q00001 
Output 1 Length always 0 
Output 2 Address %AQ00001 
Output 2 Length always 0 
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Secondary Bus (optional) 
The Genius bus controller should be configured as follows: 

In the Settings Tab 
Serial Bus Address (SBA): Any address from 0 to 29 is acceptable.  (Note:  Normally a 

Genius Handheld Monitor normally is set for SBA=0.  It is 
standard practice to avoid 0 when using Field Control or 
Genius I/O.) 

Status Reference Type: %I00449 for M23, M31, and M40 drop folders 
 %I01985 for M5S and M5L drop folders 

In the Global Data Tab 
At the GBC’s Address: 

Input 1 Address %I00001 
Input 1 Length always 0 
Input 2 Address %AI00001 
Input 2 Length always 0 
Output 1 Address %I00001 
Output 1 Length 16 plus the number of Discrete Inputs installed 
Output 2 Address %AI00001 
Output 2 Length The number of Analog Inputs installed 
 

At SBA 30: 

Input 1 Address See Buffer Registers 
Input 1 Length 62 
Input 2 Address %AI00001 
Input 2 Length always 0 
Output 1 Address %Q00001  
Output 1 Length always 0 
Output 2 Address %AQ00001 
Output 2 Length always 0  
 

At SBA 31: 

Input 1 See Buffer Registers 
Input 1 Length 62 
Input 2 %AI00001 
Input 2 Length always 0 
Output 1 %Q00001 
Output 1 Length always 0 
Output 2 %AQ00001 
Output 2 Length always 0 

The table shown below should be used to configure the Genius bus controller(s) in a remote 
drop.  The table lists the register references that must be entered into the Logic Developer 
PLC hardware configuration based upon the template folder that was used to create the 
remote drop. 
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  Remote 90-30 Genius Drop Project Name 

Description 
RemDrop 

M23dxyy.zip 
RemDrop 

M31dxyy.zip 
RemDrop 

M4xdxyy.zip 
RemDrop 

M5sdxyy.zip 
RemDrop 

M5ldxyy.zip 
Receive Buffer 
Primary Bus, CPU A 
SBA-31 

%R00705 %R01729 %R09680 %R09680 %R16065 

Receive Buffer 
Secondary Bus, CPU A  
SBA-31 

%R00833 %R01857 %R09808 %R09808 %R16193 

Receive Buffer 
Primary Bus, CPU B  
SBA-30 

%R00769 %R01793 %R09744 %R09744 %R16129 

Receive Buffer 
Secondary Bus, CPU B  
SBA-30 

%R00897 %R01921 %R09872 %R09872 %R16257 

 

Configuring the Discrete Output Range 
Discrete output states are broadcast as global data from the Hot Standby PLCs.  The global 
data is intercepted by the Remote Drop and then mapped to local output states.  The mapping 
process allows output references from the Hot Standby PLCs to be translated to a different 
set of output references in the remote drop. 

For example, assume that your Remote Drop is implemented using a model IC693CPU323.   
This CPU supports a maximum of 512 discrete output addresses.  Your Hot Standby CPUs 
are each a model IC695CMU310.  This CPU supports 32640 output addresses.  The mapping 
process allows a portion of the output addresses in the range %Q00001..02048 to be mapped 
into the range %Q00001..00512 at the remote drop. 
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Configuring the Range 
1. In Logic Developer PLC, open the Remote Drop project. 

2. Using the navigator, open the Block named mxn_cfg. 

3. Edit the first rung of data moves. 

4. In the first MOVE function, a constant is moved into the reference named M_Q_ST 
(Master CPU Starting Q Ref) Enter the starting reference for the outputs that are to be 
received from the Hot Standby PLCs. 

5. In the second MOVE function, a constant is moved into the reference named L_Q_ST 
(Local Rack Starting Q Ref) Enter the starting reference for the outputs in the Remote 
Drop in that you wish to place the Hot Standby values. 

6. In the third MOVE function, a constant is moved into the reference named L_Q_LN 
(Local Rack Q Length (bits)) Enter the number of outputs that are to be mapped into 
the Remote Drop. 

7. Save the Project. 

8. Store the Project to the Remote Drop. 

 

 

MOVE
INT

MOVE
INT

MOVE
INT

1

1

IN Q M_Q_ST

%R09288
Master CPU 
Startng Q Ref

1

1

IN Q L_Q_ST

%R09289
Local Rack 
Startng Q Ref

256

1

IN Q L_Q_LN

%R09290
Local Rack Q 
Length (bits)
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Configuring the Analog Output Range 
Analog output values from the Hot Standby PLCs are intercepted by the Remote Drop and 
then mapped (i.e. the output reference may be modified) to local output references. 

For example, assume that your Remote Drop is implemented using a model IC693CPU323.   
This CPU supports a maximum of 512 analog output addresses.  Your Hot Standby CPUs are 
each a model IC695CMU310.  This CPU supports up to 32640 analog output addresses.  The 
mapping process allows a portion of the output addresses in the range %AQ00001..32640 to 
be mapped into the range %AQ00001..00032 at the remote drop. 

Configuring the Range 
1. In Logic Developer PLC, open the Remote Drop project. 

2. Using the navigator, open the Block named mxn_cfg. 

3. Edit the second rung of data moves. 

4. In the first MOVE function, a constant is moved into the reference named M_AQ_ST 
(Master CPU Starting AQ Ref) Enter the starting reference for the outputs that are to 
be received from the Hot Standby PLCs. 

5. In the second MOVE function, a constant is moved into the reference named 
L_AQ_ST (Local Rack Starting Q Ref) Enter the starting reference for the outputs in 
the Remote Drop in that you wish to place the Hot Standby values. 

6. In the third MOVE function, a constant is moved into the reference named L_AQ_LN 
(Local Rack Q Length (words)) Enter the number of outputs that are to be mapped into 
the Remote Drop. 

7. Save the Project. 

8. Store the Project to the Remote Drop. 

 
MOVE

INT
MOVE

INT
MOVE

INT

1

1

IN Q M_AQ_ST

%R09291
Master CPU 
Startng AQ 
Ref

1

1

IN Q L_AQ_ST

%R09292
Local Rack 
Startng AQ 
Ref

25

1

IN Q L_AQ_LN

%R09293
Local Rack 
AQ Length 
(words)
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Configuring the Hot Standby GBCs 
The bus controllers should be configured in the same fashion as other I/O devices. 

Configuring the Synchronized Output Variables 
Discrete and analog outputs in a Remote Drop receive values from the Hot Standby CPUs by 
way of the Synchronized Variables data exchange.  In order for outputs to update properly, 
there must be a corresponding range of Synchronized Variables that has been configured in 
Max-ON RX3i Configuration Utility. 

For example, in the configuration shown below, remote drops would be able to access 
discrete outputs only within the range %Q00001..00064.  No other discrete output data is 
being broadcast in the global data exchange, and thus no other discrete output data is 
available for the remote drops. 
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Diagnostic Tools 

Max-ON RX3i Diagnostic Tools software provides diagnostic functions that may be used to 
obtain both real-time and historical operating information from your Hot Standby system. The 
Diagnostic Tools are provided by a Proficy View project that is used to monitor the redundant 
system. 

Step 1 - Create a Max-ON RX3i Diagnostic Tool View Project 
In Proficy Logic Developer PLC: 

1. Create a new project based on the generic Max-ON RX3i Diagnostic Tool project. 
This project is added to the Machine Edition project Navigator by using the File > 
Restore Project… menu item.  Select the Project Navigator window, making certain 
that there is no project open at this time. 

 

2. Using the File menu, click on Restore Project...  

 

Chapter 
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8-2 PACSystems® RX3i Max-ON Hot Standby Redundancy – February 2009 GFK-2409A 
 

8    

3. Navigate to the Proficy Components directory, then to the Diagnostics VIEW.  Make 
certain that the selection for Files of Type has been set to Proficy Machine Edition 
(*.zip). 

 

 
 

 
When you click on Open, a new project will be added to the Proficy Navigator window. 

 

 
  

4. Give your View project a descriptive name in the Machine Edition Navigator. 
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Step 2 – Configure Ethernet Connections to the PLCs 
In order to conduct data transfers between Max-ON RX3i Diagnostics and the Hot Standby 
PLCs, you need to establish an Ethernet communication connection to the PLCs. To 
configure the Ethernet addresses of the PLCs in the View Project: 

1. Open the View project that was restored in Step 1. 

2. Expand the PLC Access Drivers node in the Navigator for the View target and select 
the PLCA device. 

 

3. Modify the Address of PLCA in the Inspector to match the IP address of PLC A in your 
Max-ON RX3i system. 

4. Repeat step 3 for PLCB. 

5. Select the Download and Start Active Target toolbar button to start the Max-ON RX3i 
Diagnostic program, or press the F9 key. 

 

 

This will launch the View project to run on your PC. 
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Step 3 – Use the Max-ON RX3i Diagnostic Tool 
Once the Diagnostic Tool starts on your PC, the main Diagnostics page will be displayed: 

 
 

System Status Clicking on this tab displays the Real-time Status page.  The page 
contains information on scan times, update rates, and PLC status. 

Alarms Clicking on this tab will bring up the Alarm Table display page.  This 
page lists any alarms that have been archived within the PLCs that 
have active connections.  Alarms may be cleared from this display 
page. 

Project Info Clicking on this tab will display the Project Information page.  Catalog 
number, version number, program checksum, and other items are 
displayed.   

Authorization Clicking on this tab will display the Authorization page that indicates if 
the system is operating in Demo mode or not. 

 

Please note that if the Diagnostic Tool is not communicating with the PLCs, a  will be 
displayed for the items. 

The  symbol indicates a Latched Alarm condition, where a  symbol indicates a current 
Alarm condition. 
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System Status 
You may view items that relate to the current operating characteristics of your system on the 
System Status page. An example is shown in the picture above. 

PLC A and PLC B Status Indicates the operating status of the corresponding PLC, either 
Running or Stopped. 

Local Scan Time The scan time, in milliseconds, for the Local PLC. 
Remote Scan Time The scan time, in milliseconds, for the Remote PLC. 
%R Update Time This is the time required to update synchronized data of type %R.  

The time is reported in seconds. 
%AQ, Q, M Update Time This is the time required to update all configured synchronized data 

of the types %AQ, %M, and %Q.  The time is reported in seconds. 
Failover Mode This field indicates the mastership status of the corresponding PLC, 

either Master or Backup.  There never should be two Masters or two 
Backups in a system that is operating properly. 

PLC A and PLC C Identity A-Preferred, B-Preferred, or Float 
Program Restart The local CPU has been switched from STOP mode to RUN mode. 
Power Up The local CPU has undergone a power-up event. 
Remote CPU Offline The companion PLC is offline.  This may be due to the CPU being in 

STOP, Fault, or Powered Off.  Also it may be due to a cable problem 
or Ethernet Interface failure. 

Data Sync OK This field indicates the completion status for the transfer of 
synchronized data.  The Backup CPU will indicate either Synced (all 
Synchronized Variables have been received) or Not Synced.  The 
Master CPU always indicates Synced (ON). It is ON in the Backup 
CPU at the moment when all Synchronized Data items have been 
updated. 

Authorization This indicates that the corresponding PLC is running on a Max-ON 
RX3i CPU, or operating in DEMO mode.  In a system that is running 
on a Max-ON RX3i CPU, this flag will be OFF. 
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Alarms 
Historical information is stored in the alarm table.  This table contains archived information for 
up to 32 alarm records for each PLC.  The records store information for both system alarms 
and optional user-defined alarms.  Each alarm record consists of an identifier for the event 
that initiated the entry, along with a date/time stamp to indicate when the event occurred.  
Typical events include change of Hot Standby mastership, loss of PLC power, program 
restart, and loss of I/O devices. 

 

 

Note: User defined alarms are not available in the current version of Max-ON RX3i Diagnostic 
Tools.
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Project Information 

You may view certain items that relate to the general nature of your system.  Select the 
Project Info tab. 

 
  

PLC Catalog Number The catalog number of the GE Fanuc controller that is running the 
Max-ON RX3i project. 

SW Version The current version number of the Max-ON RX3i PLC drivers 
User Version Number If Audit trail has been enabled, then this represents the number of 

times the application logic has been changed.  If Audit trail has not 
been enabled, then the Max-ON RX3i drivers will not update any 
value here. 

User Version Date If Audit trail has been enabled, then the current date and time will be 
posted here each time the application logic is changed. If Audit trail 
has not been enabled, then the Max-ON RX3i drivers will not update 
any value here. 

Program Size An approximate program size.  There will be a slight difference 
between the value displayed in Logic Developer PLC and the value 
displayed here.  The Max-ON RX3i value includes the memory 
overhead associated with subroutines. 

Program Checksum The additive checksum for the Program. 



 
 

8-8 PACSystems® RX3i Max-ON Hot Standby Redundancy – February 2009 GFK-2409A 
 

8    

Authorization 
You may view the information related to the authorization of your system by selecting the 
Authorization tab. 

 
Status The Status field indicates whether the system is running on a Max-

ON RX3i CPU (IC695CMU310), or running in Demo mode on a 
standard RX3i CPU (IC695CPU310). 

Runtime Remaining The Runtime Remaining field indicates how much demo time remains 
when the system is in Demo mode. 
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System Considerations 

General Max-ON RX3i Considerations 
There are a number of considerations and recommendations that should be taken into account 
when defining a Max-ON RX3i system. This appendix summarizes the main items that the 
application developer should keep in mind when planning and developing such a system. 

1. Ethernet Synchronization LAN should use dedicated Ethernet Interface Modules. If other 
devices such as I/O or HMIs are placed on the Sync LAN, they can have a negative 
impact on the performance of the system in terms of Failover and Synchronization time. 
Therefore, it is recommended that the Sync LAN be isolated. Adding a single device like 
the Logic Developer PLC programmer or the Max-ON RX3i Diagnostic tool should be 
acceptable and also useful when diagnosing the system.  

2. Ethernet I/O LANs should use dedicated Ethernet Interface Modules and be isolated 
from a main Ethernet network. Again, if other devices are placed on the I/O LAN, they 
can have a negative impact on the performance of the I/O system in terms of IO update 
time. Therefore, it is recommended that the I/O LAN be isolated. 

Improving Ethernet Sync Efficiency Using PLC Sweep Mode 
For the Ethernet Synchronization interfaces to work efficiently, it is necessary to extend the 
Scan Time in one or both of the PLCs.  The extra time is used to transfer Synchronized 
Variables through the CPU Communications Window.  There are two approaches.  Each has its 
own advantage. 

Automatic Mode Selection 
In this approach, the system detects which CPU is the Backup and then sets the Backup to 
Constant Sweep.  If there is a transfer in Mastership, then the Max-ON RX3i driver will set the 
new Master CPU into Normal Sweep and the new Backup to Constant Sweep. 

Why you should consider this approach: 

▪ The Master always operates with the fastest Scan Time possible. 
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▪ The Backup will adjust its timing regularly to meet current system requirements. 

The period for Constant Sweep is determined automatically once per second.  The value is 
calculated by adding 75 milliseconds to the Master’s Scan Time and then rounding downward to 
the nearest multiple of 5 milliseconds. 

To enable this mode of operation: 

1. Using Logic Developer PLC, open your Max-ON RX3i Project. 
2. Select the PLC_COMMON_CODE Target as the Active Target. 
3. Prior to the call to HBR_000 in the _MAIN Block, enter a rung that sets AUTSWP 

(%M1012) to ON. 
4. Store the Logic into CPU A. 
5. Store the Logic into CPU B. 

Manual Mode 
The second method is to configure the CPUs to execute in Constant Sweep mode.  The 
configuration is entered via the Logic Developer PLC Hardware Configuration.  Both of the 
hardware configurations for targets PLC_A_HW and PLC B_HW must be set and then stored 
into the corresponding CPUs. 

Why you should consider this approach: 

▪ By having the Master in Constant Sweep mode, Ethernet communications with HMIs 
may be improved dramatically. 

Prerequisite:  The system has been commissioned and is operating in its normal fashion: 

▪ All application logic has been completed and is being executed in the hot-standby CPUs 

▪ HMIs are attached and communicating 

▪ All peripherals are connected and operating normally 

The procedure is as follows: 

Using Logic Developer PLC, record the peak CPU Scan Time in the Master CPU.  You should 
observe the system for several minutes to obtain this value. 

1. Add 75 to the value you obtained in step 1.  Round this value down to the nearest 
multiple of 5. 

2. Open the hardware configuration for CPU A. 
3. Zoom into the CPU module.  Click on the Scan tab. 
4. Set the Sweep Mode to Constant Sweep. 
5. Set the Sweep Timer to the value calculated in step 2. 
6. Store the configuration into CPU A. 
7. Open the hardware configuration for CPU B. 
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8. Repeat steps 3 through 6. 
9. Store the configuration into CPU B.  
10. Using Logic Developer PLC, Select the PLC_COMMON_CODE Target as the Active 

Target. 
11. Prior to the call to HBR_000 in the _MAIN Block, enter a rung that resets AUTSWP 

(%M1012) to OFF. 
12. Store the Logic into CPU A. 
13. Store the Logic into CPU B.  

 

Hot-Swapping IC693/IC694BEM331 Modules  
Genius Bus Controller modules IC693/694BEM331 that are included in a Max-ON redundancy 
system should not be removed from or installed in the PLC that is operating as a Master.  If a 
module is removed from the Master and then reinstalled, the outputs for that module will not be 
enabled until the next Backup-to-Master transition. 
 

Note:  Any time a Genius bus controller is removed or installed in an active system, there is a 
possibility that the bus may be disrupted with a subsequent impact on the corresponding I/O 
devices.  For systems that require online maintainability, it is recommended that dual 
(redundant) Genius busses be used. 
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Frequently-Asked Questions 

Does Max-ON RX3i Configuration Tools generate my Logic Developer PLC hardware configuration? 
No.  You must create the Hardware Configuration in the Logic Developer PLC project to match 
the parameters defined in the Max-ON RX3i Configuration Tool. 

Is the hardware configuration in the Max-ON RX3i Project used in any fashion? 
Yes.  The memory limits on the CPU must be set to be compatible with your application 
requirements.  Note that you may have to adjust these in the PLC_A_HW and PLC_B_HW 
targets as well. 

Can Max-ON Configuration Tools append the drivers onto one of my existing application folders. 
No.  You must start by creating a Max-ON RX3i Project and then add your application to it.   Or, 
you can add the Max-ON RX3i driver blocks to an existing Project using the Toolchest drawer 
supplied with the Max-ON RX3i software. 

My two CPUs will not start. What is wrong? 

There are several possibilities.  You should use Max-ON RX3i Diagnostic Proficy View Project 
to display the Fault Tables in the PLCs. 

 
Error Message Possible Cause 

Invalid CPU ID, 
Duplicate IDs 

The checksum word lengths are incorrect.  CPU A should be 
configured to have a checksum word length of 32.  CPU B should 
be configured to have a checksum word length of 16. 

%Q Configuration Fault, 
%AQ Configuration Fault, 
%M Configuration Fault, 
%R Configuration Fault 

One or more of the Synchronized Data types that you have 
configured is greater than the maximum quantity allowed for the 
product on which the project is based. 
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My system indicates that both PLCs are Masters.  What is wrong? 
The two PLCs are not exchanging Ethernet Sync LAN data properly. 

▪ If the system is being started up for the first time, then there may be a problem with the 
hardware configuration for the Ethenet Interface modules.  Or, there may be a problem with 
the LAN cabling. 

I stopped one of my CPUs and then disabled the Max-ON RX3i PLC drivers in the remaining CPU.  
Now my Genius output devices aren’t working.  What has happened? 
You will need to change the configuration in the Genius bus controllers.  In the Logic Developer 
PLC Hardware Configuration, open your Max-ON RX3i Project, zoom into the bus controller and 
set Output at Start to Enabled.  Store the new configuration into the CPU.  Make certain that you 
do this for both CPUs.  Redundant operation is affected adversely by these settings.  Don’t 
forget to change the configuration to Disabled when you are ready to run the Max-ON RX3i 
drivers again. 

CPU A has stopped.  I know that the demo period has expired, but I can’t get the CPU running 
again.  What can I do? 
Make certain that you turn ON %M1016 while the CPU is in STOP.  Then restart the CPU.  This 
will re-initialize the CPU to run in Demo Mode for an additional 22 days. 

Can I use my existing Max-ON RX3i Configuration Tools to create new projects or do I need to re-
install the software each time? 

You may use the Max-ON RX3i Configuration Tools as often as you like.  However, you will 
need to purchase a copy for each PC that you want to run the Configuration Tool on. The 
software license for IC646MXN001 is a single-user license.  

When I view the EGD Status word for the System Data Transfers, it often contains a value of 5 (Stale 
Data.)  Is this a problem? 
No… you may ignore this value.  The Produced data rate is set at 10 milliseconds which is less 
than one half the period of the PLC Scantime.  This has been done to make certain that at least 
one exchange will be produced in every scan.  In many scans there will be two (or more) 
exchanges.  In these extra exchanges, the same data is being transferred multiple times, hence 
the message “Stale Data”. 
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I would like to transfer some information from the Backup to the Master PLC.   Is this possible? 
Yes.  There are five word references available for “Reverse Data Transfers”. 

T_Buff R_BuffP R_BuffS CommBuff 

W40070 W40146 W40222 W49612 

W40071 W40147 W40223 W49613 

W40072 W40148 W40224 W49614 

W40073 W40149 W40225 W49615 

W40074 W40150 W40226 W49616 

Data that is to be transferred to the companion PLC should be placed in one or more of the 
Transmit Buffer words (T_Buff). 

Data from the companion PLC may be retrieved by reading from the corresponding Common 
Buffer (CommBuff). 

The other two buffers contain the received data on the Primary and Secondary Ethernet Sync 
LANs.  If the Primary LAN is functioning, then its data is moved into the CommBuff.  If the 
system is configured for dual Sync LANs AND the Primary fails, AND then the Secondary buffer 
is available, then the secondary is moved into the CommBuff.  If neither LAN is available then 
the buffer is cleared. 
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Quick Start Guide Using Ethernet I/O 

This appendix uses an example Max-ON RX3i Redundant system with two controllers to give an 
overview of the steps needed to set up Max-ON RX3i systems with Ethernet NIUs for the I/O. 

1. Create List of ENIUs and I/O like the example shown below. The list should include: 

▪ Controller(s) with IP addresses and local I/O (if used).  

▪ Each ENIU with IP Address, and the I/O for the ENIU. Leave expansion space for 
additional I/O if the system is likely to change or grow. 

Example System with Redundant Controllers 
    Ethernet Synchronization LinkPrimary  

PLC A 
IP 10.10.10.2 

%I1 – 32 
%Q1 – 32 
%AI1 – 16 
%AQ1 - 16 

ENIU 11 
IP 10.10.10.11 

%I33 – 64 
%Q33 – 64 
%AI17 – 32 
%AQ17 - 32 

ENIU 12
IP 10.10.10.12 

%I65-128 
%Q65 - 96 
%AI (none) 
%AQ (none) 

ENIU 13
IP 10.10.10.13 

%I129 - 256 
%Q97 - 128 
%AI 33 - 56 
%AQ (none) 

Secondary 
PLC B 

IP 10.10.10.3 
%I1 – 32 
%Q1 – 32 
%AI1 – 16 
%AQ1 - 16 

IP 100.100.100.2IP 100.100.100.1

 
 

A Machine Edition backup folder  to start from is provided with the Max-ON RX3i Software:  

▪ Max-ON RX3i Quick Start 3 ENIUs 
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2. In Proficy Logic Developer PLC, create a new project based on the Project named above. 
This project is added to the Machine Edition project Navigator by using the File > Restore 
Project… menu item.  Select the Project Navigator window making certain that there is no 
project open at this time. 

 

3. Using the File menu, click on Restore Project...  

 

4. Place the Max-ON RX3i Installation CD in your CD drive and navigate to the Quick Start 
directory.  Make certain that the selection for Files of Type has been set to Proficy Machine 
Edition (*.zip). 
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When you click on Open, a new project will be added to the Proficy Navigator window.  

5. Give your project a descriptive name in the Machine Edition Navigator. 

6. The Quick Start project is set up with controller targets named Primary_Controller (PLC A) 
and Secondary_Controller (PLC_B) and 3 ENIUs named ENIU11, ENIU12, ENIU13. You 
can rename the Targets as appropriate. If you need fewer ENIUs, delete the ones you don’t 
need. If you need more ENIUs, select hardware configuration of a ENIU, right click and 
export the configuration. Create a new ENIU target, select hardware configuration, right click 
and import the hardware configuration. You will need to adjust the IP address before 
proceeding to the next step. 

7. Using the list you created in step 1, change the hardware configuration for the controllers 
and ENIU to match the I/O in your project. Make sure the I/O reference addresses are 
correct.  

8. Adjust the Produced exchange of the ENIUs and the Consumed exchange of the 
Controller(s) to match the %I and %AI in the hardware configuration of the ENIUs. 

9. If you are changing the IP addresses of the devices, you need to change the following items: 

▪ IP address of each device. This must be done in two places: in the properties of the 
Target (how programmer connects) and in the Ethernet settings in hardware 
configuration.  

▪ Subnet mask of each device (if required). 
▪ Gateway IP address of each device (if required). 
▪ Check the Local Producer ID of each device and verify it is the IP address. 
▪ For Consumed Exchanges, change the Producer ID of the Exchange  

10. Set default values for variables. 

11. Download configurations to the Targets. 

When downloading to new or unknown hardware, first set the physical port property of the 
device in the programmer to a serial comm port  (com1) and connect via a serial cable to the 
power supply port. After the initial store of the configuration sets the IP Address, the physical 
port property can be set to Ethernet and the IP address entered. This will allow connection 
of the programmer via Ethernet. 
If you know the device’s MAC Address, an alternative process is to use the Set IP Utility in 
Machine Edition to set a temporary IP address so that you can connect to the devices from 
Logic Developer PLC. 
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12. To launch the Max-ON RX3i Configuration Utility, Open the Supplemental Files, 
Documentation Files directory of the PLC_COMMON_CODE Target:  

 

 
 

13. Select the Max-ON Project directory: 
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14. Double-click on the config.mx3 file. This will launch the Max-ON RX3i Configuration Utility 
that can used to define the parameters of the Redundant System. 

 

 
 

15. When the parameters of the Redundant Systems are entered or modified using the 
Configuration Utility, the cfg_dat C block is updated in the Max-ON Project directory. This 
block then must be used to update the C Block in the PLC_COMMON_CODE of the Project. 
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16. Select the C Block Update… right mouse menu and select the cfg_dat C Block gefelf file. 
 
 

 
 
 
 
 

 

17. At this point the updated Configuration Utility parameters have been added to the Max-RX3i 
project. Now download the updates to the Primary and Secondary controllers. 
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Updating an Existing Application 

This appendix explains how to upgrade the Max-ON program blocks in your application to a 
newer version of Max-ON using the Proficy Toolchest. 

Overview 
The general sequence for updating an application is as follows: 

1. Revise the Hardware Configurations 

•  Update the existing hardware configuration for the target named PLC_A_HW.  Include 
any changes that need to be made, especially the EGD exchanges. 

•  Update the existing hardware configuration for the target named PLC_B_HW. (Again, 
considering changes to EGD exchanges.) 

2. Revise the Application with new Max-ON Drivers 

3. Download both Hardware Configurations  

Note:  Make certain that both PLCs have been downloaded with the revised hardware 
configurations before proceeding with the logic download. 

•  Select the hardware target that is associated with the Backup PLC.  Set it as the Active 
Target. 

•  Go online and place the Backup PLC into STOP mode. 

•  Download (Hardware only) the appropriate hardware target to the Backup PLC. 

•  Place the Backup PLC in RUN Mode. 

•  Go offline.  

•  Switch Mastership so that the current Backup becomes the Master. 

•  Select the hardware target that is associated with the new Backup PLC.  Set it as the 
Active Target. 
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•  Go online and place the Backup PLC into STOP mode. 

•  Download (Hardware only) the appropriate hardware target to the Backup PLC while it is 
in STOP mode. 

•  Place the Backup PLC in RUN Mode. 

•  Go offline. 

4. Download the Application Logic 

Note:  Make certain that both PLCs have been downloaded with the revised hardware 
configurations before proceeding with the logic download. 

•  Set PLC_COMMON_CODE as the Active Target. 

•  Adjust the target’s Ethernet I.P. address to match the address of the Backup PLC.  (Or if 
using a serial connection, connect to the programming port on the Backup PLC.) 

•  Download (Logic only) the target named PLC_COMMON_CODE into the Backup PLC.  

•  Place the Backup PLC in RUN Mode.  

•  Go offline.  

•  Switch Mastership so that the current Backup becomes the Master.  

•  Adjust the target’s Ethernet I.P. address to match the address of the Backup PLC.  (Or if 
using a serial connection, connect to the programming port on the Backup PLC.) 

•  Download (Logic only) the target named PLC_COMMON_CODE into the Backup PLC.  

•  Place the Backup PLC in RUN Mode. 

 

Additional information on how to revise the three Max-ON targets follows. 
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Updating an Existing Max-ON RX3i Application 
If you have a Max-ON RX3i application that was created using an earlier version of Max-ON 
RX3i software, such as version 3.04, you must update the Max-ON Drivers in your application 
to take advantage of issue resolutions in later versions.  A Machine Edition Toolchest drawer is 
provided on the Max-ON RX3i Software Release CD to aid in the upgrade process. 

To upgrade an existing Max-ON RX3i application, perform the following steps: 

Backup the Application 
Back-up your Max-ON RX3i application using the Backup feature in Machine Edition. 

1. Make certain that all projects are closed so that only the current projects are displayed in 
the Navigator window. 

2. Select the project that is to be backed-up.  (In this example it is 06Feb17_DPCS.) 

 

3. Right-click on the project and the following menu list will be displayed. 

 

4. Select Back UP and the following dialog box will be displayed. 
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5. Navigate to the directory in which you wish to save the backup copy of the project. 

6. Make certain that the file is saved as a Zip File (*.zip), and then click on Save. 
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Updating from Releases Prior to 3.14 
In release 3.14, the system state values are transferred by way of Ethernet Global Data 
Exchanges (EGD). 

Note:  If your application is based upon a release prior to 3.14, then you MUST configure the 
EGD Exchanges in PLC_A_HW and PLC_B_HW before you may update the application logic. 

Add EGD Exchanges to PLC A 
Select the target named PLC_A_HW.  Right-click on the target to display the pop-up menu.  
Click on “Add Component►Ethernet Global Data”.  A new component named “Ethernet Global 
Data” will be added to the target. 

 

 

Set the Producer ID 
Go to the Navigator window and click on Ethernet Global Data so that you may edit the 
properties. 
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Go to the Inspector window and edit Local Producer ID so that the IP address corresponds to 
the IP address that was set for the Primary LAN Ethernet module in PLC A. 

  

 

Primary LAN EGD 

Consumed Exchange 

In the Navigator window, expand Ethernet Global Data to reveal the Consumed and Produced 
exchanges. 

 

Right-click on Consumed Exchanges.  The following pop-up menu will be displayed. 
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Click on New to create the first Consumed Exhange.  The default name for the exchange is 
ConsExch1.  In the Inspector window, set these properties as follows:  

Name Set to MxnCons1  
Producer ID Set to the IP address of the Primary Ethernet module in PLC B. 
Group ID Defaults to 0 
Exchange ID Defaults to 1 
Adapter Name Set to location of Primary ETM (normally Rack 0, Slot 4)  
Consumed Period 200 (not configurable) 
Update Timeout Defaults to 0 (no Timeout) 
Run Mode Store Defaults to False 

  

 

In the Navigator window, double-click on MxnCons1.  This will create a new tab in the 
InfoViewer window so that you can configure the properties of the consumed exchange.  The 
new tab is shown below. 
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In the InfoViewer window, click on the Add button to add a new item to the table.  The window 
will appear as shown below. 

 

 

Complete the configuration for the exchange by editing the parameters as illustrated in the table 
that follows. 

MxnCons1 (Primary LAN) 

Offset (Byte.Bit) Variable Ref Address Ignore Length Type 

Status  %W49620  1 WORD 

TimeStamp  %W49621  4 WORD 

0.0  %W40077  76 WORD 

 

Produced Exchange 

In the Navigator window, right-click on Produced Exchanges.  The following pop-up menu will 
be displayed. 

 

Click on New to create the first Produced Exhange.  The default name for the exchange is 
ProdExch1.  In the Inspector window, set these properties as follows:  

Name Set to MxnProd1 
Exchange ID Defaults to 1  
Adapter Name Set to location of Primary ETM (normally Rack 0, Slot 4)  
Destination Type Defaults to Unicast 
Destination Set to the IP address of the Primary ETM in PLC B 
Produced Period Set to 10 
Reply Rate 0 (not configurable) 
Send Type Always (not configurable) 
Run Mode Store Defaults to False 
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In the Navigator window, double-click on MxnProd1.  This will create a new tab in the InfoViewer 
window so that you can configure the properties of the produced exchange.  The new tab is 
shown below. 

 

 

In the InfoViewer window, click on the Add button to add a new item to the table.  The window 
will appear as shown below. 
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Complete the configuration for the exchange by editing the parameters as illustrated in the table 
that follows. 

MxnProd1 (Primary LAN) 

Offset (Byte.Bit) Variable Ref Address Ignore Length Type 

Status  %W49619  1 WORD 

0.0  %W40001  76 WORD 

 

Secondary LAN EGD (optional) 

LAN IP Address 

In this release of Max-ON, the Secondary LAN must use the same IP address settings as used 
for the Primary LAN. 

Consumed Exchange 

These exchanges are similar to the Primary exchanges except for the Reference addresses that 
are set in the properties table. 

Refer to the procedure used for the Primary exchange and then set the table properties as 
shown below: 

MxnCons2 (Secondary LAN) 

Offset (Byte.Bit) Variable Ref Address Ignore Length Type 

Status  %W49630  1 WORD 

TimeStamp  %W49631  4 WORD 

0.0  %W40153  76 WORD 

 

Produced Exchange  

Refer to the procedure used for the Primary exchange and then set the table properties as 
shown below: 

MxnProd2 (Secondary LAN) 

Offset (Byte.Bit) Variable Ref Address Ignore Length Type 

Status  %W49629  1 WORD 

0.0  %W40001  76 WORD 
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Add EGD Exchanges to PLC B 
Select the target named PLC_B_HW.  Right-click on the target to display the pop-up menu.  
Click on “Add Component►Ethernet Global Data”.  A new component named “Ethernet Global 
Data” will be added to the target. 

 

 

Set the Producer ID 
Go to the Navigator window and click on Ethernet Global Data so that you may edit the 
properties. 
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Go to the Inspector window and edit Local Producer ID so that the IP address corresponds to 
the IP address that was set for the Primary LAN Ethernet module in PLC B. 

  

 

Primary LAN EGD 

Consumed Exchange 

In the Navigator window, expand Ethernet Global Data to reveal the Consumed and Produced 
exchanges. 

 

Right-click on Consumed Exchanges.  The following pop-up menu will be displayed. 
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Click on New to create the first Consumed Exhange.  The default name for the exchange is 
ConsExch1.  In the Inspector window, set these properties as follows:  

Name Set to MxnCons1  
Producer ID Set to the IP address of the Primary Ethernet module in PLC A 
Group ID Defaults to 0 
Exchange ID Defaults to 1 
Adapter Name Set to location of Primary ETM (normally Rack 0, Slot 4)  
Consumed Period 200 (not configurable) 
Update Timeout Defaults to 0 (no Timeout) 
Run Mode Store Defaults to False 

  

 

In the Navigator window, double-click on MxnCons1.  This will create a new tab in the 
InfoViewer window so that you can configure the properties of the consumed exchange.  The 
new tab is shown below. 
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In the InfoViewer window, click on the Add button to add a new item to the table.  The window 
will appear as shown below. 

 

 

Complete the configuration for the exchange by editing the parameters as illustrated in the table 
that follows. 

MxnCons1 (Primary LAN) 

Offset (Byte.Bit) Variable Ref Address Ignore Length Type 

Status  %W49620  1 WORD 

TimeStamp  %W49621  4 WORD 

0.0  %W40077  76 WORD 

 

Produced Exchange 

In the Navigator window, right-click on Produced Exchanges.  The following pop-up menu will 
be displayed. 

 

Click on New to create the first Produced Exhange.  The default name for the exchange is 
ProdExch1.  In the Inspector window, set these properties as follows:  

Name Set to MxnProd1 
Exchange ID Defaults to 1  
Adapter Name Set to location of Primary ETM (normally Rack 0, Slot 4)  
Destination Type Defaults to Unicast 
Destination Set to the IP address of the Primary ETM in PLC A 
Produced Period Set to 10 
Reply Rate 0 (not configurable) 
Send Type Always (not configurable) 
Run Mode Store Defaults to False 
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In the Navigator window, double-click on MxnProd1.  This will create a new tab in the InfoViewer 
window so that you can configure the properties of the produced exchange.  The new tab is 
shown below. 

 

 

In the InfoViewer window, click on the Add button to add a new item to the table.  The window 
will appear as shown below. 
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Complete the configuration for the exchange by editing the parameters as illustrated in the table 
that follows. 

MxnProd1 (Primary LAN) 

Offset (Byte.Bit) Variable Ref Address Ignore Length Type 

Status  %W49619  1 WORD 

0.0  %W40001  76 WORD 

 

Secondary LAN EGD (optional) 

LAN IP Address 

In this release of Max-ON, the Secondary LAN must use the same IP address settings as used 
for the Primary LAN. 

Consumed Exchange 

These exchanges are similar to the Primary exchanges except for the Reference addresses that 
are set in the properties table. 

Refer to the procedure used for the Primary exchange and then set the table properties as 
shown below: 

MxnCons2 (Secondary LAN) 

Offset (Byte.Bit) Variable Ref Address Ignore Length Type 

Status  %W49630  1 WORD 

TimeStamp  %W49631  4 WORD 

0.0  %W40153  76 WORD 

 

Produced Exchange  

Refer to the procedure used for the Primary exchange and then set the table properties as 
shown below: 

MxnProd2 (Secondary LAN) 

Offset (Byte.Bit) Variable Ref Address Ignore Length Type 

Status  %W49629  1 WORD 

0.0  %W40001  76 WORD 
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Update the Max-ON Drivers 
1. Import the latest Max-ON RX3i Driver Toolchest drawer into Machine Edition.  

a. Open your Max-ON RX3i Project in Machine Edition. 

b. Open the Toolchest by pressing the Toolchest button on the Toolbar –or- by 
pressing Shift+F9. 

c. Select a node in the Toolchest. 

d. Using the right-mouse button, select Import Drawer. 

 

 

e. Navigate to the Max-ON RX3i Driver Toolchest drawer located on the Max-
ON RX3i Software Release CD. The file is named: Max-ON RX3i Drivers 
v3_nn.ZDRW, where nn indicates the release number. 
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f. Press the Open button. This will add the drawer to your Toolchest. 

2. Expand the MaxON_Components folder in the PLC_COMMON_CODE Target in 
your project to display the current set of Max-ON Drivers. If you examine the Block 
Properties of each Block, you can see your current Block revision, such as v3.04. 

3. Delete the Max-ON Driver blocks that start with “hbr_” from the MaxON_Components 
folder. 

 
DO NOT delete the cfg_dat C Block. 
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4. Add the version Max-ON RX3i Drivers to the MaxON_Components folder directory 
using the Ctrl-Drag-and-Drop operation from the Toolchest.  

  
  

The Blocks must be added to the Machine Edition Project in the following order: 

a. hbr_001, hbr_005, hbr_008 

b. hbr_099 

c. hbr_002 hbr_003, hbr_004, hbr_006, hbr_007, hbr_009, hbr_010, hbr_011, 
hbr_cfg 

d. hbr_000 

5. When performing the Ctrl+Drag-and-Drop Toolchest operation, when the Variable 
Conflict Resolution dialog is displayed, you must select the “Replace all existing 
variables” option to ensure that any new MaxON RX3i variables are properly 
defined. 
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6. A MaxON_RX3i_MAIN Block is also available in the Toolchest Drawer. This Block 
has a comment in the first rung that details the revision history. 

7. Validate your Max-ON RX3i application to verify that all Max-ON Driver blocks are 
properly located in the Project. 

8. You can also verify the version of each hbr_ Block by checking the description in the 
Block Properties: 

  

 



Index 
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